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THHEﬂTGH Warning and Disclaimer

Warning and Disclaimer

ThreatQuotient, Inc. provides this document “as is”, without representation or warranty of any
kind, express or implied, including without limitation any warranty conceming the accuracy,
adequacy, or completeness of such information contained herein. ThreatQuotient, Inc. does

not assume responsibility for the use or inability to use the software product as a result of

providing this information.
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Introduction

The following provides an introduction to the ThreatQ platform.

« ThreatQ Introduction

o Concept Overview

ThreatQ Introduction

ThreatQ is a cyber threat intelligence platform that focuses on centralizing, structuring, and

strengthening a security organization's intelligence-driven defensive posture against attacks.

Concept Overview

The following describes how ThreatQ helps organizations manage threat intelligence, allow-

ing them to defend against sophisticated cyber-attacks.

o Threat Library

o Adaptive Workbench

« Open Exchange

Threat Library

A central repository combining global and local threat data to provide relevant and con-
textual intelligence that is customized for your unique environment. Over time, the library
becomes more and more tuned to your environment and fills in the intelligence gaps created

by different sources, all providing only some pieces of the puzzle.
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Adaptive Workbench

An open and extensible work area for security experts across the organization to work within
your processes and tools. A customizable workflow and customer-specific enrichment

streamlines investigations and analysis, and automates the intelligence life cycle.
Open Exchange

ThreatQ is the only threat intelligence platform specifically designed for customization to
meet the requirements of your unique environment. Get more from your existing security
investments by integrating your tools, teams and workflows through standard interfaces and

an SDK/API for customization.
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System Access

The following describes how to login and log out of the platform.

o System Access Overview

« System Login

« Managing your User Account

« 2 Step Verification

System Access Overview

To access the ThreatQ web Ul, you must authenticate yourself with a username and pass-

word. You can use the main menu to access ThreatQ functionality.

System Login

When you installed ThreatQ, you set up the default user account, Maintenance Account,

which you can use to log into the web UL.

Using this account, you can create additional user accounts.

Passwords must be 15 characters or longer. There is no limit on the character type.
Logging into ThreatQ

When you installed ThreatQ, you defined an IP address for the web Ul, and set up the Main-

tenance Accountand password.

1. In your web browser, navigateto https://your-ThreatQ-web-ip-

address.
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Password

Login

2. Enter your username (email address) and password.

3. Optionally, if you have 2-step verification enabled, complete the following steps:
« Enter your verification code from Google Authenticator.
« Optionally, choose to Remember this computer for 30 days.

4. Click Login or Submit.

Session Timeout

User sessions time out after 30 minutes of inactivity.

Managing your User Account

When you choose the Settings icon > My Account, the system directs you to the Edit User
page for your current login. From here, you can edit your user account, set up 2-step veri-

fication, or view your login history.
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Procedure

1. Choose the Settings icon > My Account.

Users that have upgraded to ThreatQ 4.1 will see an avataricon in
place of the My Account link. Click on the icon and select My
Account.

2. On the User Profile tab, you can edit the following settings of your user account:
« Name
o Title
o Email
« Password

3. You can update your user avatar; see Update User Avatar.

ﬂ\ The User Avatar feature is only available with ThreatQ 4.1 and later.

4. Optionally, you can set up 2-step verification; see 2 Step Verification.

5. Optionally, on the Login Activity tab, you can view:
« The last date and time you logged in.
« The IP Address where you logged in.
« Whether the login was successful or not.

6. Click Save.

User Avatar Icons

G\ The User Avatar feature is only available with ThreatQ 4.1 and later.

User avatar icons provide a personalized look to your ThreatQ dashboard. Clicking on the

avatar icon will reveal the My Account and Log out options.
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Users can update their avatars by clicking on the avatar and selecting My Account.

« Update User Avatar Graphic

Update User Avatar Graphic

[ G The User Avatar feature is only available with ThreatQ 4.1 and later.

1. Click on avatar icon located to the top-right on the screen and select My Account.

The Edit Userform will load.

2. Click on the green Add User Avatar button and select the icon graphic to upload.

{ ﬂ Users can also click and drag the new icon graphic onto the page

3. Click on Save at the bottom of form.

2 Step Verification

When you enable 2-Step Verification (also known as two-factor authentication), you add an
extra layer of security to your account. After 2-Step Verification is active, you sign in with your

password and a code sent to your mobile device.

o Enabling 2 Step Verification

Enabling 2 Step Verification
Procedure:

1. Choose the Settings icon> My Account.
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Users that have upgraded to ThreatQ 4.1 will see an avataricon in
place of the My Account link. Click on the icon and select My
Account.

2. Under Enable 2-Step Verification, click Turn On.
3. Inthe Enable 2 Step Verification dialog box, complete the following:
« Scan the gr code using your Google Authenticator mobile app.

« Enter the validation code delivered to your mobile device via Google

Authenticator.
o Click Submit.
4. Click Save.

What to do next

The next time you log in, you must use the newest verification code.

ThreatQ User Guide, Version 4.10
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Licensing

The following provides an overview of licensing for the ThreatQ platform.

o Licensing Overview

o Viewing the License Status

« Updating a License

Licensing Overview

Your ThreatQ deployment requires a license to initialize the platform. ThreatQ Support
provides the initial license and any subsequent licenses provided to maintain the platform.

You apply the initial ThreatQ license during first boot, as described in the ThreatQ Getting

Started Guide. Any subsequent license updates can be applied in the ThreatQ user inter-

face.

Viewing the License Status

ThreatQ licenses are not perpetual. To view the license expiration date, complete the fol-

lowing steps:
Procedure

Choose the Help icon >About .

Updating a License

If you receive a new license from Support, apply the new license by accessing the About

page.

Procedure
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1. Choose the Help icon >About .
Choose Update License.

Enter the new license key.

W N

Click Submit.
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User Management

The following describes how to manage user accounts.

o User Management Overview

« User Account Creation

« User Account Modification

User Management Overview

ThreatQ uses role-based access control to manage user accounts. The system provides sev-
eral user roles, each containing a set of permissions for accessing system functionality. You
create user accounts, and assign them to a user role. The user role determines each

account's set of permissions.

After you create a user account, you can modify the user role group, full name, and email

address.
« User Roles
User Roles

The following details the user roles and their associated permissions.

User Role Permissions

Members have access to the
Maintenance Account entire ThreatQ user interface and

can edit all data.
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User Role Permissions

Note: This account can

not be deleted

Members have access to the
Administrative Access entire ThreatQ user interface

and can edit all data.

Members have access to most of
the ThreatQ user interface, except

for:

User Management

Incoming Feeds

o Exports

Operations Management

Primary Contributor Access QAR [ G

System Configurations

Members can edit:

Their own user info

« Whitelist Management

Operations Management

Object meta data

Saved Searches
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User Role Permissions

Members have access to most of
the ThreatQ user interface, except

for:

User Management

« Incoming Feeds

« Indicator Management

« Whitelist Management
Read Only Access . Exports
« Operations Management

o OAuth Management

« System Configurations
Members cannot edit any data.

Members can export search res-
ults.

User Account Creation

When you firstinstall ThreatQ, the system creates a default user account, the Maintenance
Account. You cannot delete this account, and you can use it to initially create other user

accounts. Each user account must have a unique username.

Only the Maintenance Account and Administrative Access user role have permissions to
access user management functionality. You can only create new user accounts if logged in

as one of these roles.
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o User Account Properties

« Adding a User

User Account Properties

. full name of the user asso-  any alphabetic character and
ame
ciated with this account spaces

. . . any alphabetic character and
Title optional user title
spaces

roles which this user
Group at least one role selected
account belongs to

Email email address associated  valid email address, such as user-
mai
with this account @domain.com

initial password asso-
Password _ . all characters
ciated with the username

Adding a User

1. From the main menu, choose the Settings icon > User Manangement.
Click Add User.
Enter the user's Name.

Optionally, enter the user's Title.

o &~ B

Select the level of access for the user from the Group drop-down menu.

Choose from the following options:
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« Maintenance Account
o Administrative Access
« Primary Contributor Access
o Read Only Access
Enter the user's Email address.
Enter a password for the user.

Retype the password.

© o N o

Click Add User.

User Account Modification

After you create a user account, you can modify the account's role group, full name, title,

email address, and password.

o Editing a User

o Resetting User Passwords from the Command Line

« Deleting a User

Editing a User

1. From the main menu, choose the Settings icon > User Manangement.

2. Click the name of the user whose profile you wish to edit.
The Edit User page appears.

3. Editthe user fields as desired; see User Account Properties.

4. To change the password, click Change Password.

5. Click Save.
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Resetting User Passwords from the Command Line

If you have root access to your ThreatQ installation, you can reset any user's password from

the command line.

1. Login to the ThreatQ command line as root.

2. Navigate to the api directory:
cd /var/www/api
3. Run the following command:
sudo php artisan threatqg:password-reset

4. Atthe prompt, enter the email address for the user whose password you are reset-
ting.
5. Atthe prompt, enter the new password.

6. Atthe prompt, re-enter the new password to confirm.

Deleting a User
Deleting a user cannot be undone.

1. From the main menu, choose the Settings icon > User Manangement.
2. Select the user(s) you wish to delete.

3. Click the Delete. icon.
A confirmation dialog box appears, asking if you are sure.

4. Click Delete Users.
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System Configurations

The following describes how to manage various system configurations in ThreatQ.

o System Configuration: Indicator Statuses

System Configuration: Indicator Types

System Configuration: Event Types

System Configuration: Proxy

LDAP Authentication

System Configuration: Date and Time Format

System Configuration: Indicator Statuses

The System Configuration: Indicator Statuses page allows you to view, duplicate, add, edit,
and delete available system-wide indicator statuses. You cannot edit and delete indicator
statuses provided by ThreatQ, but you can add new statuses and edit or delete your custom

statuses.

Indirect Indicator Status

For feeds that set multiple statuses, A status of Indirectis assigned to indicators that meet the

following criteria:
« Indicators created from the relations array are imported with a status of Indirect.

« Ifanindicator already exists, its original status value will remain the same. However, if
the status is Indirect, and itis received as a parent indicator, its value will be updated

as defined in the connector configuration.

Currently, this status only applies to CrowdStrike and iSight feeds, where:
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« For CrowdStrike, Indirectindicates that ThreatQ received the indicator from the

relations list for the parent indicator.

« ForiSight Partners, Indirectindicates that ThreatQ received an indicator that does

not have an attribute of Attack or Compromised.

Viewing Indicator Statuses
To view existing indicator statuses, complete the following procedure.
Procedure:
1. Choose the Settings icon > System Configurations.
The System Configurations page opens to the Indicator Statuses tab.

Statuses found within ThreatQ are listed by status, number, and description within the

Indicator Statuses table.

2. Optionally, to sort the table by a column, click the column header. To reverse the

column sorting order, click the header a second time.

Adding an Indicator Status

To add an indicator status that can be applied to any system indicator, complete the fol-

lowing procedure.
Procedure:
1. Choose the Settings icon > System Configurations.
The System Configurations page opens to the Indicator Statuses tab.

Click Add New Status.
Enter a Status Name.

Optionally, enter a Status Description.

o &~ B

Click Add Status.
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Editing an Indicator Status

To edit an existing indicator status, complete the following procedure. You cannot edit indic-

ator statuses provided by ThreatQ.
Procedure:
1. Choose the Settings icon > System Configurations.
The System Configurations page opens to the Indicator Statuses tab.

2. Determine the indicator you want to edit and click Edit in the far right column.
3. Optionally, enter a new Status Name.

4. Optionally, enter a new Status Description.

5

. Click Save Changes.

Deleting an Indicator Status

To delete an indicator status, complete the following procedure. You cannot edit and delete
indicator statuses provided by ThreatQ. Custom statuses can only be deleted if there are no

indicators using that status.
Procedure:
1. Choose the Settings icon > System Configurations.
The System Configurations page opens to the Indicator Statuses tab.

2. Determine the indicator you want to delete and select the corresponding checkbox

in the first column.
3. Click the Delete icon in the upper right hand corner.

4. Click Delete Statuses.
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System Configuration: Indicator Types

The Indicator Types table allows you to view a list of indicator types found in ThreatQ and

the number of those indicators within the system.
To view Indicator Types found within ThreatQ:
1. Go to ThreatQ Configuration > System Configurations.
The System Configurations page opens.
2. Click the Indicators sub-tab.
The Indicator Types page opens.
From the Indicators sub-tab, the following functions are available:
« Viewing existing indicators by type and number

Indicators found within ThreatQ are listed by type and number in the Indicator Types
table.

System Configuration: Event Types

The System Configuration: Events page allows you to view, add, and delete system events.
Event types provided by ThreatQ cannot be edited or deleted, but you can add new event

types and edit or delete your event types.
Custom statuses can only be deleted if there are no indicators using that event type.
To view Event Types found withing ThreatQ:

1. Go to ThreatQ Configuration > System Configurations.

The System Configurations page opens.
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2. Click the Events sub-tab.
The Event Types page opens.
From the Events sub-tab, the following functions are available:

Viewing existing events by type and number

Events found within ThreatQ are listed by type and number in the Event Types table.

Adding an event type

At the top right of the Event Types table, click + Add, and follow the steps.

Editing an event type

Editable events have an edit option in the Event Types table. Click edit, and follow the

steps.
« Deleting an event type

Select the event type(s) you wish to delete, and click Delete at the top right of the

Statuses table.

Changing the number of entries displayed in the table

Click the dropdown menu at the top right of the table and select the desired option.

Sorting the table by a column

Click the column header. To reverse the column sorting order, click the header a

second time.

System Configuration: Proxy

The System Configuration: Proxy page allows you to enable or disable proxies.
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A Users are required to set their proxy server settings to use http: for their
https: traffic. The ThreatQ Proxy Configuration page can be found by nav-
igating to Settings > System Configuration > Proxy.

Access Proxies
To access proxies:
1. Go to ThreatQ Configuration > System Configurations.
The System Configurations page opens to the Statuses sub-tab.
2. Click the Proxy sub-tab.
The Proxy Configuration table appears.
From the Proxy sub-tab, the following functions are available:
« Enabling a proxy for HTTP or HTTPS traffic

Check the correct proxy type and enter configuration details. Click Save Changes.

ThreatQ will check that the proxy has been configured properly.

« Disabling a proxy for HTTP or HTTPS traffic

Uncheck the proxy you wish to disable, and click Save Changes.

LDAP Authentication

ThreatQ allows you to configure system access via LDAP, the Lightweight Directory Access
Protocol. You can configure a basic LDAP or configure a secure connection to your LDAP

server.

When configuring LDAP, it is important to note the following:
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« Local users and LDAP users may exist on the same system.

« ThreatQ will check the LDAP user table first for any attempted login, then fall back

to the local user table if no entry is found in the LDAP directory.

Note: Currently, ThreatQ supports LDAP authentication on LDAP servers run-
ning OpenLDAP 2.4, Active Directory 2008, and Active Directory 2012. If you

are using a different configuration, please contact ThreatQ Support.

« Required Information for Creating LDAP Authentication

« Configuring LDAP

o Configuring Secure LDAP

Required Information for Creating LDAP Authentication

Before you configure a connection to your LDAP server, you should work with your LDAP

administrator to collect, at minimum, the following information:

« the server name or IP address for the server where you plan to connect

« the server type of the server where you plan to connect, typically LDAP for basic
and LDAPS for secure LDAP

« if possible, the base distinguished name for the server directory where the user

names reside

Configuring LDAP

For ThreatQ to identify different user types, your LDAP server should include groups under

an organizational unit, OU, for each user role:

« Maintenance Account

« Administrative Access
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« Primary Contributor Access

o Read Only Access

Note: Only users with an Administrative or Maintenance account can access

LDAP settings.

Procedure:

1. Choose the Settings icon > System Configurations.
2. Choose LDAP from the System Configurations toolbar.

3. Configure the following server settings:

Enter the name of the server where LDAP is hosted.

Server Address

For example, Idap://[servername]
Port # Typically, enter 389 for LDAP.

Enter the domain for which LDAP is configured to
LDAP Domain authenticate.

For example: threatq.com

Choose from the following options:

Append Domain to
« Yes for most Active Directory servers

Username
« No for most Open Ldap servers
This field is specific to your LDAP directory con-
Filter Field Name gt

Forexample:
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Group Field Name

Use RDN?

Organizational Unit
(OU)

User Lookup Name

« memberuid

e uid
This field is specific to your LDAP directory con-
figuration.
Forexample:
e CN
« memberof
Choose from the following options:
« Yes to use Relative Distinguished Names.

« No to use full Distinguished Names

This field is specific to your LDAP directory con-
figuration. Your LDAP administrator should provide

the correct value for this field.

This field is specific to your LDAP directory con-

figuration.
Forexample:

« memberUid, for Active Directory

« uid, for Open LDAP

4. Next, Map Your Permission Levels to LDAP, using the user groups that your

LDAP administrator established for each user role. For roles not mapped, you

should enter a hyphen: "-." You cannot save the configuration without entering a
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value in each field.

Note: You can not list the same LDAP User Group for multiple permission

levels.

« For OpenLDAP, consider the following example:

Maintenance Account IdapSuper
Administrative Access administrator
Read Only Access IdapObserver

Primary Contributor Access = IdapAnalyst

« For Active Directory, consider the following example:

Main-
tenance CN-=read-only,CN=Builtin,DC=yourdomain,DC=com

Account

Admin-
istrative CN=linux-admins,CN=Builtin,DC=yourdomain,DC=com

Access

Read Only CN=tg-maintenance,CN=Builtin,DC=yourdomain,DC=c-

Access om
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Primary Con- _ . . _
_ CN=primary-contributor, CN=Builtin,DC=yourdomain,DC-
tributor
=com
Access

5. Click the LDAP toggle switch to enable your LDAP configuration.
6. Click Save Changes.

If your LDAP fails to enable or fails to function properly, validate your inputs. If the con-

figuration continues to fail, please contact ThreatQ Support.

Configuring Secure LDAP
To configure secure LDAP, you must complete the following steps:

1. Enter your LDAP settings in the ThreatQ user interface.
2. Access the ThreatQ appliance command line as root and edit openldap.conf.

3. If necessary, run the ThreatQ LDAP utility, to retrieve your LDAP binding strings.

For ThreatQ to identify different user types, your LDAP server should include groups under

an organizational unit, OU, for each user role:

« Maintenance Account
« Administrative Access
« Primary Contributor Access

o Read Only Access

Note: Only users with an Administrative or Maintenance account can access

LDAP settings.

Procedure:
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1. Choose the Settings icon > System Configurations.

2. Choose LDAP from the System Configurations toolbar.

3. Configure the following server settings:

LDAP Domain

Server Address

Port #

Organizational Unit
(OU)

User Lookup Name

Use RDN?

Enter the domain for which LDAP is configured to

authenticate.

For example: threatq.com

Enter the name of the server where LDAP is hosted.

For example, Idaps://[servername]

Typically, enter 636 for Idaps

This field is specific to your LDAP directory con-
figuration. Your LDAP administrator should provide

the correct value for this field.

This field is specific to your LDAP directory con-

figuration.

Forexample:
« memberUid, for Active Directory
« uid, for Open LDAP

Choose from the following options:

« Yes to use Relative Distinguished Names.

« No to use full Distinguished Names
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Choose from the following options:

Append Domain to

Username « Yes for most Active Directory servers

« No for most Open Ldap servers

This field is specific to your LDAP directory con-

figuration.

Group Field Name For example:

e CN

« memberof

This field is specific to your LDAP directory con-

figuration.

Filter Field Name For example:

« memberuid

e uid

4. Next, Map Your Permission Levels to LDAP, using the user groups that your
LDAP administrator established for each user role. For roles not mapped, you
should enter a hyphen: "-." You cannot save the configuration without entering a

value in each field.

Note: You can not list the same LDAP User Group for multiple permission

levels.
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« For OpenLDAP, consider the following example:

Maintenance Account IdapSuper
Administrative Access administrator
Read Only Access IdapObserver

Primary Contributor Access = IdapAnalyst

« For Active Directory, consider the following example:

Main-
tenance CN-=read-only,CN=Builtin,DC=yourdomain,DC=com

Account

Admin-
istrative CN=linux-admins,CN=Builtin,DC=yourdomain,DC=com

Access

Read Only CN=tg-maintenance,CN=Builtin,DC=yourdomain,DC=c-

Access om
Primary Con- _ . o .
_ CN=primary-contributor, CN=Builtin,DC=yourdomain,DC-
tributor
=com
Access

5. Click the LDAP toggle switch to enable your LDAP configuration.
6. Click Save Changes.

7. Access the ThreatQ command line as root.
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8. Use vi to edit /etc/openldap/ldap.conf. Make sure that your settings are as follows:

#
# LDAP Defaults

#

# See ldap.conf(5) for details

# This file should be world readable but not world writable.

BASE dc=[your domain],dc=com

URI ldap://[your servername]:389 ldaps://[your servername] :636

#SIZELIMIT 12
#TIMELIMIT 15

#DEREF never
TLS_CACERTDIR /etc/openldap/certs

# Turning this off breaks GSSAPI used with krb5 when rdns =
false
SASL NOCANON on

TLS REQCERT allow

Caution: ThreatQ recommends that you edit Idap.conf on the appliance,
rather than editing off box and uploading it. If you do edit the file off box,
ensure that you use a linux editor. Windows and Mac editors may corrupt
the file.

If your LDAP fails to enable or fails to function properly, validate your inputs. If the con-

figuration continues to fail, please contact ThreatQ Support.
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System Configuration: Date and Time Format

You can configure the date and time format of your choice system-wide within the ThreatQ

platform.

Note: If you make changes to the date and time format while another user is

working concurrently in the same ThreatQ installation, that user must refresh

their browser for the changes to take effect.

o Configuring Date and Time Format

Configuring Date and Time Format

1.

From the navigation menu, choose the gear icon > System Configurations.

. From the System Configurations menu, choose General.
. Select the desired Date Format.

2
3
4,
5

Select the desired Time Format.

. Click Submit to save your settings.
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Incoming Feeds

The following describes how to use incoming feeds to ingest threat intelligence data.

o Incoming Feeds Overview

« Managing Incoming Feeds

o Historic Feed Pulls

Incoming Feeds Overview

You can enable and manage incoming feeds in ThreatQ to ingest threat intelligence data.

Incoming feeds are organized into the following categories:

Commercial

o OSINT or Open Source
o STIX/TAXII Feeds
« Labs

Commercial Feeds

Commercial feeds are provided by paid feed providers as a service. To enable these feeds
in ThreatQ, you will need an API ID or API Key from the provider. Commercial feeds typically
provide highly contextual threat intelligence data. You can learn more about these feeds on

their vendor's websites.

OSINT Feeds

OSINT feeds are open source threat intelligence feeds. Open source feeds are free to use,

but some may require you to register with the feed provider to attain an API Key.
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STIX/Taxii Feeds

STIX stands for Standard Threat Information Expression, itis an emerging standard for the
sharing of machine readable intelligence and incident data. A STIX package is an XML doc-
ument that can contain many indicators and related context information. For the automated
sharing of STIX packages, a protocol called TAXII (Trusted Automated eXchange of Indic-

ator Information) is used to provide a feed to consumers.

ThreatQ provides a feature for consuming STIX/Taxii feeds.

Labs Feeds

Labs (formerly known as ThreatQ Labs) are driven by ThreatQuotient's Threat Intelligence
Services Team. Labs feeds provide a solution for data ingestion that is not provided by the
feeds pre-configured with the ThreatQ platform. You should inquire with a Threat Intel-

ligence Engineer to see what Labs are available.

Managing Incoming Feeds
Manage threat intelligence feeds on the Incoming Feeds page.
The following table describes the actions you can take to manage Incoming Feeds.

_

Turn a feed on or off Toggle the switch next to the feed name.

Click Feed Settings for the feed you
Editing a feed’s display name or URL _ _ _ _
wish to edit, and make desired edits.

ThreatQ User Guide, Version 4.10 53



THREA Tﬂ H Incoming Feeds

Install CDF Command

The command below will allow you to install a Configuration Driven Feed in your applic-

ation. The command creates connectors for each feed defined in the feed definition file.

sudo /var/www/api/artisan threatq:feed-install

<Feed Definition File>

The application will notify you if a feed in the feed definition file already exists in the system
and will abort the installation. You can add an upgrade flag to the command to allow the

application to update an existing feed.

sudo /var/www/api/artisan threatq:feed-install

<Feed Definition File> --upgrade

You can also see a full list of command flags using the following command:

$ /var/www/api/artisan threatq:feed-install --help

Enabling a Commercial Feed

To enable a commercial feed, you will need an API ID and API Key provided by the feed pro-

vider.
Procedure:

1. Choose the Settings icon > Incoming Feeds.

2. Click the toggle switch next to the feed you want to enable.

Green indicates enabled.
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3. Expand Feed Settings.
4. On the Connection tab, enter:
« Feed Name - the name displayed in ThreatQ
« APIID - provided by the feed vendor for authorization

API Key - provided the feed vendor for authorization

» Feed URL - this field is autofilled

5. On the Settings tab, select:
« the status thatincoming indicators from this feed will receive.
« the frequency that ThreatQ pulls information from the feed.

6. Click Save Changes.

Enabling an OSINT Feed

OSINT feeds do not require API IDs, but some may require an API key from the feed pro-

vider.
Procedure:

1. Choose the Settings icon > Incoming Feeds.

2. Click the toggle switch next to the feed you want to enable.
Green indicates enabled.

3. Expand Feed Settings.
4. On the Connection tab, enter:
« Feed Name - the name displayed in ThreatQ
« API Key (if required) - provided the feed vendor for authorization

« Feed URL - this field is autofilled
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5. On the Settings tab, select:

« the status thatincoming indicators from this feed will receive.
« the frequency that ThreatQ pulls information from the feed.

6. Click Save Changes.

Viewing Feed Queues

When upgrading a feed, itis recommended to allow the previous implementation the feed to
complete processing of the data it has already downloaded, prior to upgrade, to avoid any

data loss.

Perform the following steps to confirm that the queues have been cleared.

1. Run the following command:

/var/www/api/artisan threatq:list-queues -p

feeds

2. Locate and confirm that the feed’s Indicators and Reports rows display a value of

"0" for the Messages Ready and Messages Unacknowledged columns.

The queues should be cleared, reporting 0 values, before pro-
ceeding with the update.

Adding a New STIX/Taxii Feed

Complete the following steps to add a new STIX/TAXIl indicator feed.

Procedure:

1. Choose the Settings icon > Incoming Feeds.

2. Choose Add New Taxii Feed.
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10.

. What would you like to name this feed? Enter the feed name that will be displayed

throughout ThreatQ. It does not need to match the Collection Name.

How often would you like to pull new data from this feed? Choose Every Hour or

Every Day.
Enter the Discovery URL where the TAXII server can be reached.
Optionally, enter a Poll URL.

Enter the Collection Name, which is the name of the collection of data on the feed

you would like to access.

If required for the feed, under Login Credentials, enter a Username and Password.
If required for the feed, under Certificates/Keys, enter a Certificate and Private
key.

Choose Add TAXII Feed.

CrowdStrike CDF

Starting with ThreatQ version 4.2, the CrowdStrike feed will be updated to use the con-

figuration driven method. This update will allow users to review an Activity Log that will

provide a summary of the feed and including important details such as:

how the feed was triggered,
start and completion time,
raw response received from the vendor,

how many objects were processed by ThreatQ.

Query Range

Query Range is a new feature with this update that uses the exact date/time that ThreatQ

queried CrowdStrike’s API for information.
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This feature, unique to the updated CrowdStrike feed, ensures that there isn't a gap in feed
coverage in the event of a feed run failure or server downtime. ThreatQ will use the last com-

pleted run time when performing a new run.

Example: Customer has CrowdStrike configured to perform scheduled runs every hour. The
customer powers down the server for three hours for maintenance. The next time the feed
runs, it will automatically use the last successful run time in its range which will cover the

three-hour gap when the server was down.
PlaceHolder Files

The Placeholder file concept is currently used by the updated CrowdStrike feed with expan-
ded support to other feeds to be added in future releases. Placeholder files prevent linking
information delays between the vendor and ThreatQ by creating a placeholder file imme-
diately after receiving a file or report from the vendor. ThreatQ will fulfill the placeholder and
update the object information accordingly. ThreatQ will mark placeholder files on the details

and file overview pages.
Related Information

o CrowdStrike Update Instructions

« Performing Manual Feed Runs

CrowdStrike Update Instructions

A CrowdStrike users must update their proxy server settings to use http: for
their https: traffic before upgrading CrowdStrike.

Prior to upgrade, and to avoid any data loss, itis recommended to allow the previous imple-

mentation of CrowdStrike to complete processing of the data it has already downloaded.

Perform the following steps to confirm that the queues have been cleared.
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1. Run the following command:

/var/www/api/artisan threatqg:list-queues -p

feeds

2. Locate and confirm that the CrowdStrike Indicators and Reports rows display a

value of "0" for the Messages Ready and Messages Unacknowledged columns.

The queues must be cleared, reporting 0 values, before proceeding
with the update.

3. Proceed with the standard feed update procedures.

-

ﬂ The update process is quick. A confirmation message will confirm
that the update process is complete. The Activity Log feature will
load once CrowdStrike is enabled and a feed run instance has been
created or completed.

A

Feed Activity Log

The feed activity log summarizes each feed run, including information such as how the feed
was triggered, its start time, completion time, the raw response received from the feed

vendor, and how many objects were processed.
The Activity log is currently available for the following Configuration-Driven Feeds (CDF):
Commercial Feeds

o CrowdStrike

« Cofense Intelligence (formerly known as Phishme Intelligence)

OSINT Feeds
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o AlienVault OTX

« All abuse.ch feeds, except for abuse.ch SSBL (Extended)
o Bambenek

« BitSight

o ClArmy List IPs

« Cybercrime Tracker

« Emerging Threats Compromised IPs
« malcOde Domain

« malcOde IP

« Malware Domain List (IP)

» Malware Patrol

o Phishtank
Viewing a Feed's Activity Log
To view a feed's activity log, that feed must be enabled.
Procedure

1. From the main menu, choose the Settings icon > Incoming Feeds.
2. Choose a feed and expand Feed Settings.

3. Choose the Activity Log tab.

Historic Feed Pulls

Historic pulls provide a method for you to ingest threat intelligence data from a particular
vendor prior to the date you enabled the incoming feed. The procedure for running historic

feeds varies based on the type of feed.

See the following topics for more information:
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Feeds that do not Support Historic Pulls

Performing Manual Feed Runs

iSight Historic Pull Command

« General Historic Pull Commands

Threat Intelligence Services Custom Feeds Historic Pull Commands

Feeds that do not Support Historic Pulls
The following feeds do not support historic pulls:

o All OSINT feeds
« The following Commercial Feed:

o DeepSight
Performing Manual Feed Runs

For some feeds, you can perform a manual feed run for a selected date range. This allows

you to generate a historic feed pull from the user interface.

You can perform a manual feed run for the following feeds:
o CrowdStrike

Procedure:

1. From the main menu, choose the Settings icon > Incoming Feeds.
Select a feed and expand Feed Settings.

Click +Manual Run.

Select a Start Date, Start Time, and Time Zone for your run.

Select an End Date, End Time, and Time Zone for your run.

o o A w N

Click Queue Run.
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iSight Historic Pull Command

To run an iSight historic pull, run the following command from the command line, substituting
your desired start and end date:

sudo isight connector -s MM-DD-YYYY -e MM-DD-YYYY

General Historic Pull Commands

If not called out specifically in Historic Feed Pulls, use the following commands at the com-

mand line to run historic pulls for most other connectors, including most TAXII feeds.

1. Run the following command to determine the feed name ($SFEEDNAME):

tgconnector -h

Take note of the desired feed name.

2. Run the following command to run the historic pull, substituting your desired start

and end date:

sudo -u threatqg tgconnector -f SFEEDNAME -s MM-
DD-YYYY -e MM-DD-YYYY

Threat Intelligence Services Custom Feeds Historic Pull Commands

Custom feeds provided by Threat Intelligence Services provide a mechanism for you to gen-
erate a historic pull during the initial feed run. After the initial feed run, feeds typically perform

an hourly pull, but can be adjusted within cron.

Refer to the documentation for your custom feed or integration for more information.
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Dashboard

The following describes how to use the dashboard to view various threat intelligence met-

rics.

Dashboard Overview

Dashboard Overview

The Dashboard displays metrics and visualizations to provide at-a-glance views of your

threat intelligence data, including:

« Overview of intelligence by score

Watchlist activity

Incoming intelligence

Open assigned tasks

The dashboard serves as your landing page when you log in to ThreatQ.

Overview of Intelligence By Score

This dashboard graph provides a summary of indicator scoring in the system. It lists total

indicators by score in the following order:

Very High

« High

Medium

o Low
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o Very Low

« Not Scored

You may click on the percentage/number of indicators to launch an indicator search based

on that criteria.

@ Overview of Intelligence by Score

VERY HIGH 0% (0)

0% (1)

MEDIUM 0% (0)

0% (0)

VERY LOW 100% (192,379)

NOT SCORED 0% (0)

Incoming Intelligence

This dashboard graph provides a view of threat intelligence from all incoming feeds. The sys-

tem categorizes threat intelligence by:

« Feed Name
« Total number of indicators reported by a source
« Indicators reported by a source with a status of active

« All indicators reported by a source per day (includes existing indicators)
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@ Incoming Intelligence

Feed Name Total © Active ® o
All Feeds 188,571 16,027
DeepSight Advanced IP Reputation Attack XM... 70,443 13,645
DeepSight Advanced IP Reputation CnC XML ... 3,861 2,481

iSight Partners 40 40

SecureWorks Abuse.ch Feodo IP Tracker 0 0

Emerging Threats IQRisk Rep List FQDNs

DigitalShadows

DeepSight Advanced IP Reputation Fraud XM...

DeepSight Advanced IP Reputation Bot XML F...

CrowdStrike

Watchlist Activity

This dashboard section provides a view of the intelligence data that you selected to watch.

You may click on any accompanying link to view the details page of the item being watched.
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P Watchlist Activity

Adversaries (1/1)

(M  156.201.135.172

Activity

Manual Score added

Generated Score added
googleads2. publicvm.com linked

Source added

Class added

Watchlist

Files (1/1)

Source

CrowdStrike

CrowdStrike

CrowdStrike

CrowdStrike

CrowdStrike

i Since Wednesday

Indicators (6/6)

When

04/12/2018 06:05pm
04/12/2013 06:05pm
04/12/2018 06:05pm
04/12/2018 06:05pm

0471272078 06:04pm

The Watchlist allows you to track threat intelligence data and user activity of interest from a

view on the dashboard.
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THREATQ 3 Indicalors  Evenls  Adversaries  Files  Signatures

o Qv of Intelligence by Score

VERY HIGH 0% (0}
HIGH 0% {09
MEDIUM 0% [0}
LOW 0% [0)
VERY LOW 100% [670,375)

0% (0)

@ Incoming Intelligence

Feed Name Total @ Active @ = Daily @
Al Faeds 670,375 121,897

AlisnVault OTX 62,747 G2 74T

Configuring the Watchlist

At Watchlist Activity

Events (11

@i 176.111.18.16

Activity

Source added

18-0D00EZ12 Indicalor Re

Exec Summary sdoed
Manual Score adoed

Generated Score added

Inactive (4]

Adversaries (0

Source

Sam Jackson

Sight Partners

Sight Partners

Sight Partners

Signt FPartners

Signatures (11)

When

04/18:2018 01:38pm
04162018 02:57am
04162018 02:568m
04162018 02:568m

04162018 02:568m

To create a watchlist that displays on the dashboard, complete the following steps:

1. From the ThreatQ user interface, navigate to the Details page of the indicator,

event, adversary, file, or signature you want to track.
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2. Click Add to Watchlist to track that item.
THRmTo 3 Inccators: Events Adversanes Fies Signatures

[;-]\ googleads2.publicvm.com
. FOON

SCORE: | 0-VeryLow = L

8 DETAILS

Attributes

Attribute Type Attribute Value Source
O Confidence High Crowdsinke
O Matware Family nyRAT CrowdEinke
O  Astack Phase c2 Crowgsinke
O  wort "y CrowdStrike
O Fart 1188 CrowdStnke
Sources
CrowdSinke

Q e- o

STATUS: Active =

Date Updated

OB8/237201 5 03:40am

0812372015 03:40am

0812372015 03:40am

0812372015 03:40am

082372015 03:40am

3. Return to the dashboard to view your watchlist.

Viewing Tasks on the Dashboard

This dashboard widget provides a view of all open tasks in the platform. You can view your

open tasks or view all open tasks. Tasks on the dashboard are categorized by:

e TaskID

Task Name

o Userthe Task is Assigned To

Due Date

Status.
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Search

The following describes how to search for indicators and other objects using ThreatQ's

search features.

« Search Overview

« Finding Items By Object Type

o Wildcards and Symbols in Searches

Search Overview

Search allows you to find objects you are looking for quickly, without having to browse

through a large number of objects. There are three search features in ThreatQ:

« Basic Search, which offers a quick method to search if you know exactly what you

are looking for.
« Advanced Search, which gives you more options for limiting your search.

« Indicator Search, which served as the legacy advanced search prior to ThreatQ ver-

sion 4.0.

Using these varieties of search, you can create as broad or as granular a view of your data

as desired.
For more information, see:

« Basic Search

o Advanced Search

« Indicator Search
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Basic Search

Basic Search allows you to search for all objects in the system: indicators, events, adversar-
ies, files, signatures, and so on. The search capability looks at high level aspects of each

object, including:

« Indicators (network or host)

« Attachment titles, hashes, keywords
« Attributes

o Adversary name

« Eventtitle
If searching for google.com, the following indicators will also be returned:

o www.google.com (FQDN)

« analytic.google.com (FQDN)

« www.google.com/analytic (URL)

« analytic@google.com (email address)

o Performing a Basic Search

Performing a Basic Search
Procedure:

1. Choose the Search icon.

The Search dialog box appears.
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earch Indicator Search

Dwring a search, you may use a percent sign (%) to match characters in a string. For example,
specifying net3 matches network, netware, netscape, and so on: See more examples

2. Enterthe search criteria.
The Search field provides type ahead suggestions, if any, based on what you have

typed.
3. Select the desired result.

« If you do not retrieve any search results, we recommend trying the

Advanced Search.

« Ifthere is only one result, the object details page appears.

Advanced Search

Advanced Search allows you to search Indicators, Events, Adversaries, Files, Signatures,
and so on for mentions of one or more search keywords that can exist in the object or any of
its attributes. You can easily add and remove keywords to try out many search combinations.

After fine-tuning your search results, you can save your search queries for later use.

Advanced search serves as the landing page when you select an object type from the

Threat Library menu.

« Performing an Advanced Search

« Refining Your Advanced Search

o Saving Searches
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o Choosing Attributes to Display in Search Results

« Exporting Search Results to a CSV file

Performing an Advanced Search
Build your object search by category, optionally including one or more keywords.

1. Choose the Search icon.
. In the Search dialog box, choose Advanced Search.

. Under Threat Library, choose your object search category.

2
3
4. Optionally, under Global Filters, enter a keyword to narrow your search.
5. Press Enter or Return.

6

. Optionally, repeat steps 4 and 5 to further narrow your search.

Refining Your Advanced Search
After performing an advanced search, you can refine your search results by applying filters.

» Filtering a Search by Last Modified

Filtering a Search by Last Modified

Complete the following procedure to display Advanced Search results by the date objects

were last modified.
Procedure:

1. Choose the Search icon.
In the Search dialog box, choose Advanced Search.

Perform an Advanced Search, as described in Performing an Advanced Search.

> W N

Choose Filters > Last Modified.
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5. Select one of the following options to determine how the filter is applied:

is before - search results include items before a selected date

is after - search results include items after a selected date

« isin the range of - search results include items in a selected range of dates

is within the last - search results include items within the selected number of

days.
6. Use the controls to select date options based upon the selection in step 5.

7. Click Save.
Filtering a Search by Dated Created

Complete the following procedure to display Advanced Search results by the date objects

were created.

Procedure:

—

. Choose the Search icon.
In the Search dialog box, choose Advanced Search.

Perform an Advanced Search, as described in Performing an Advanced Search.

Choose Filters > Date Created.

o &~ B

Select one of the following options to determine how the filter is applied:
« is before - search results include items before a selected date
« is after - search results include items after a selected date
« is between - search results include items in a selected range of dates

« is within the last - search results include items within the selected number of

days.
6. Use the controls to select date options based upon the selection in step 5.

7. Click Save.
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Saving Searches

If you are following a particular area of interest, you can create a Saved Search. Saved

Searches can then be run at any time.

1.

2
3
4.
5
6

Choose the Search icon.

. In the Search dialog box, choose Advanced Search.

. Perform an Advanced Search.

Choose Save.

. In the Save Search dialog box, enter a name for the search.

. Choose Save Search.

Running Saved Searches

Complete the following steps to run a Saved Search.

1.
2.
3.

Choose the Search icon .
In the Search dialog box, choose Advanced Search.

Choose Saved Searches and then select the desired saved search from the list.

Deleting Saved Searches

Complete the following steps to delete a Saved Search.

1.

Choose the Search icon .

. In the Search dialog box, choose Advanced Search.

2
3.
4

Choose Saved Search and then choose the desired saved search from the list.

. Click the Delete icon.

Choosing Attributes to Display in Search Results

You can choose which attributes to display in your search results by completing the fol-

lowing steps:
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1.

2
3
4.
5

Choose the Search icon .

. In the Search dialog box, choose Advanced Search.

. Perform your search.

Choose Manage Columns.

. Select the attributes you wish to display. Clear the attributes you wish to hide.

Exporting Search Results to a CSV file

You can export your search results as a CSV file, which allows you to use the data in

another application, such as external spreadsheet software.

e

G If you export a file with too many search results, the file may be too large to

open in desktop applications. If you encounter this issue, you should sep-
arate your exports into smaller chunks of data.

ﬂ\ When exporting search results to a CSV file, if you include additional

columns beyond the default, this modification will impact the performance
of the export process.

N

. Choose the Search icon .

In the Search dialog box, choose Advanced Search.
Perform your search.

Choose Export.

The CSV file downloads to your desktop.

Clearing Your Search

Complete the following steps to clear your search, so that you may begin a new search.

1.
2.
3.

Choose the Search icon.
In the Search dialog box, choose Advanced Search.

Perform and refine your search.
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4. In the Search field, choose clear all filters.

5. In the dialog box, choose Reset Search.

Filter by Attributes

"l

The Filter by Attribute feature is available with ThreatQ version 4.6 and
later.

The Filter by Attribute option allows users to filter search results by Attribute Types and Val-

ues.
Using the Attributes filter, users can:
« Filter search results to include/exclude objects using a specific Attribute Type and

Attribute Value.

« Filter search results to include/exclude objects using a specific Attribute Type and

any Attribute Value.

« Filter search results to include/exclude objects using multiple Attribute filters.
Users will also have the option to set the filter to include objects that fit one of the

multiple filters or all.
See the following topics for more details:

o Filter Using WITH Attribute Option

Filter Using WITHOUT Attribute Option

Edit Existing Attribute Filter

Apply Multiple Filters

Common Scenarios
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Filter Using WITH Attribute Option

The Filter by Attribute feature is available with ThreatQ version 4.6 and
later.

Using the With Attribute filter allows users to include objects with a specific attribute.
From the search results:
1. Click on the Filters option and select With Attribute.
The Attribute modal will open.

2. Select an Attribute Type.

3. Enter an Attribute Value associated with the Attribute Type.

Users can leave the Attribute Value field blank to filter for any value
associated with the selected Attribute Type.

4. Click on Add to apply the filter.

Filter Using WITHOUT Attribute Option

The Filter by Attribute feature is available with ThreatQ version 4.6 and
later.

Using the Without Attribute filter allows users to exclude objects with a specific attribute.
From the search results:
1. Click on the Filters option and select Without Attribute.
The Attribute modal will open.

2. Select an Attribute Type.
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3. Enter an Attribute Value associated with the Attribute Type.

Users can leave the Attribute Value field blank to filter for any value
associated with the selected Attribute Type.

4. Click on Add to apply the filter.

Edit Existing Attribute Filter
Users can edit existing Attribute filters applied to the search results.
From the search results:
1. Click on the Filters option and select they type of filter option to edit.

Example: If you are editing a Without Attribute, select Without Attribute option from
the Filter dropdown.

The Attribute modal will open.

2. Make all the required updates and click on Add to apply the updated filter.

Apply Multiple Filters

Users have the ability to apply multiple Attribute filters to the search results. Users also have

the ability to configure Any/All options for the filters to include objects that fit one of the filters
orall.

1. Click on the Filters option and select either Without or With Attribute.
The Attribute modal will open.
2. Selectan Attribute Type.

3. Enter an Attribute Value associated with the Attribute Type.
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Users can leave the Attribute Value field blank to filter for any value
associated with the selected Attribute Type.

4. Click on the plus icon to the right of the modal to add another attribute and repeat
steps 2-3.
5. Click on the Add button.

The filters will be applied to the search results.

G The Match Any/All toggle option will allow users to configure the filter to
include objects that either fit one attribute filter or both. The Any option will
be selected by default. This means the filter will display results that fit any
of the attribute filters. The All option means the filter will display results that

fit all attribute filters.

Example:
ANY - Match Toggle Selection

Setting Field Value

Attribute Type Attack Phase
Filter A

Attribute Value C2

Attribute Type Severity
Filter B

Attribute Value High

Filter Options Any/All Toggle Any
Result Search Results are filtered to include objects with Attack Phase: C2
esu
OR Severity: High attributes.

ALL - Match Toggle Selection
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Setting Field Value

Attribute Type Attack Phase
Filter A

Attribute Value C2

Attribute Type Severity
Filter B

Attribute Value High

Filter Options Any/All Toggle All
Result Search Results are filtered to include objects with Attack Phase: C2
esu
AND Severity: High attributes.

Common Scenarios
The following scenarios demonstrate the Attribute Filter option in use with search results.
Applying a "With Attribute" filter (All items with an Attribute Type and Value)

1. User clicks on the Threat Library tab and selects on the Indicators tab.

2. User clicks on the Filters button and select With Attribute.

The Attribute Filter modal pops up with an attribute form.

3. User selects Attack Pattern as the Attribute Type and C2 as the Attribute Value.

4. User clicks on Add.

The User will now see a search parameter With Attribute with Attack Pattern: C2
listed. The search results update to show all Indicators with an attribute of Attack

Pattern: C2.
Applying a "Without Attribute" filter (All items without an Attribute Type and Value)

1. User clicks on the Threat Library tab and selects on the Indicators tab.
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2. User clicks on the Filter button and select Without Attribute.

The Attribute Filter modal pops up with an attribute form.

3. User selects Attack Pattern as the Attribute Type and C2 as the Attribute Value.

4. User clicks on Add.

The User will now see a search parameter With Attribute with Attack Pattern: C2
listed. The search results update to show all Indicators without an attribute of
Attack Pattern: C2.

Applying a "Without Attribute" filter (All items Without a specific Attribute Type with any

Value)

1. User clicks on the Threat Library tab and selects on the Indicators tab.

2. User clicks on the Filters button and select Without Attribute.

The Attribute Filter modal pops up with an attribute form.

3. User selects Attack Pattern as the Attribute Type and leave the Attribute Value
blank.

4. User clicks on Add.
The User will now see a search parameter Without Attribute with Attack Pattern

listed. The search results update to show all Indicators that do not have an Attrib-

ute Type of Attack Pattern assigned to them.

Applying keyword filters then applying a "With Attribute" filter
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1. User clicks on the Threat Library tab and selects on the Indicators tab.

2. User searches for keyword: demo.

The User will see a search parameter listed Keyword: "demo" and the results

update to show only indicators that mention demo.

3. User clicks on the Filters button and select With Attribute.

The Attribute Filter modal pops up with an attribute form.

4. User selects Attack Pattern as the Attribute Type and C2 as the Attribute Value.

5. User clicks on Add.

The User will now see a search parameter With Attribute with Attack Pattern: C2
listed. The search results will update to show all Indicators that mention the
keyword demo AND have an attribute of Attack Pattern: C2.

Editing multiple attributes that were applied as part of the search parameters

1. User clicks on the Threat Library tab and navigates to the Indicators tab.

2. User clicks on the Filter button and select With Attribute.

The Attribute Filter modal pops up with an attribute form.

3. The User specifies two attributes:
«» Attack Pattern:C2
« Severity: High

4. User clicks on Add.
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The User will now see two search parameters under the With Attribute section -
Attack Pattern: C2 and Severity: High. The search results updates to show all
Indicators with an attribute of Attack Pattern: C2 and Severity: High. The search
parameter for attributes is defaulted to Any. This indicates that objects with an

attribute of Attack Pattern: C2 or Severity: High are displayed.

5. User clicks on the Filters option and selects With Attribute.

A form will load with all applied filter attributes.

6. The User clears the Attack Pattern's Attribute Value field and clicks Add.

The User will now see two search parameters under the With Attribute section:
Attack Pattern: Any and Severity: High. The search results updates to show all

Indicators with an attribute type of Attack Pattern OR Severity: High.

Add multiple attributes and toggle Match from Any to All

1. User applies two attribute filters to the indicators results: Attack Phase: C2 and

Severity:High.

The filtered results will display any indicators that has either of those attributes.

2. User clicks on the Any/All Match toggle button and select All.

The filtered results will display any indicator that has both of those attributes

Filter by Status

The Filter by Status feature is available with ThreatQ version 4.6 and later.
Users can filter search results by the object’s status.
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Users can filter Indicators, Signatures and Tasks by Status.
From the search results page:

1. Click on the Status button and select a status from the dropdown menu.

G Users can select multiple statuses using the check boxes.

The search results will update with the applied filter. A flag icon at the top of the

results list will indicate that a filter is in use.
Common Scenarios
Apply Status Filter

1. User clicks on the Threat Library tab and selects on the Indicators tab.

2. User clicks on the Status filter button and selects Active.

The results page will automatically update to show only indicators with a status of

Active.
Apply Status Filter and Type Filter

1. User clicks on the Threat Library tab and selects on the Indicators tab.

2. User clicks on the Status filter button and selects Active.

The results page will automatically update to show only indicators with a status of

Active.

3. The User clicks on the Type filter and selects IP Addresses.

The results page will automatically update to show all IP Addresses with a status of

ThreatQ User Guide, Version 4.10 84



THREA T['J' H Search

Active

Apply Multiple Status Filters

1. User clicks on the Threat Library tab and selects on the Indicators tab.

2. User clicks on the Status filter button and selects Active.

The results page will automatically update to show only indicators with a status of

Active.

3. User clicks on the Status filter button and selects Expired.

The results page will automatically update to show all indicators with a status of
Expired OR Active.

Filter by Source

The Filter by Source feature is available with ThreatQ version 4.6 and
later. Users can filter search results by the object’s source.

From the search results page:
1. Click on the Filters option and select Source
A source header will load above the results.

2. Click on the Add Source link and select the source to used in the filter.

3. Repeat step 2 to add multiple Source filters to the results.

Users applying multiple Source filters to the results can use the
Must Match toggle option to determine whether the objects match
Any or All of the sources identified in the filter.
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Indicator Search

Indicator Search allows you to search indicators based on a wide range of modifiers and
search criteria. For example, when searching for an event, the results will include all indic-

ators related to that event.

Using indicator search will provide the total number of indicators matching
the criteria of your search, however, the page will only load 1,000 indic-
ators within the results table.

With respect to searching for IP Address or CIDR Block indicators, your results will be as fol-

lows:

« If searching for an IP Address, CIDR blocks will be returned if they fall within the

range.

« If searching for CIDR blocks, IP addresses will be returned if they fall within the

range.

This will search indicator values as well as Attribute of type “IP
Address” (for instance, if an IP address is associated to another IP
address through a passive DNS relationship).

Performing an Indicator Search
Procedure

1. From the main menu, click the Search icon.
The Search dialog box appears.
2. Click Indicator Search.
The Indicator Search page appears.
3. Select the desired search parameters and operators using the dropdown menus,

and enter the values.
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Parameter Operator

Is

Is not

Is Blank

Is Not Blank

Indicator Class

Contains
Does Not Contain
) Is
Indicator Value
Is not
Is Blank

Is Not Blank

Contains
Does Not Contain
] ] Is
List of Indicators
Is not
Is Blank

Is Not Blank

Is

Is not

Is Blank

Is Not Blank

Indicator Status

Is

Is not

Is Blank

Is Not Blank

Indicator Type

Is
Is not
Is after
Date Created Is before
Is in the range of
Is Blank
Is Not Blank

Date Last Modified Is not

Is after
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Parameter Operator

Is before

Is in the range of
Is Blank

Is Not Blank

Contains
Does Not Contain
] Is
Attachment Title
Is not
Is Blank

Is Not Blank

Contains
Does Not Contain
Is
Adversary
Is not
Is Blank

Is Not Blank

Contains
Does Not Contain
Is
Event Title
Is not
Is Blank

Is Not Blank

Is

Is not

Is Blank

Is Not Blank

Event Type

Contains
Does Not Contain
] Is
Attribute
Is not
Is Blank

Is Not Blank
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Click + to add more parameters. When your search consists of more than one para-
meter, you can select and or or using the dropdown menu between the search para-

meters.

4. Click Search.

Search results are displayed in a search results table.

5. (Optional) Change the number of entries shown in the search results table by

clicking the dropdown menu at the top right and selecting the desired option.

6. (Optional) Click a column header to sort the data by column, and click again to

reverse sort order.

7. (Optional) Search within a column by clicking within the search field at the top of

the column, entering a search keyword, and pressing Enter.
Results will be shown below the search query.

You can hide the query to view more of the search results.

Making Bulk Updates to Search Results

The bulk update tool allows you to make batch changes to the objects in your Search res-

ults. The tool is limited to 1000 objects per update.
Procedure:

1. From the main menu, click the Search icon.

The Search dialog box appears.

2. Click Indicator Search.
The Indicator Search page appears.

3. Perform your Indicator Search.

4. Atthe top of the Search Results, choose Make Bulk Changes to 1,000 Indicators.

The Bulk Update Tool appears.
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5. Optionally, apply a new object status by choosing from the drop down menu.
6. Optionally, enter an additional source.
7. Optionally, apply one or more attributes:

o Choose an Attribute Type from the drop down menu.

« Enter an Attribute Value.

« Enter an Attribute Source.

« Optionally, choose the add icon to apply additional attributes.

8. Optionally, relate your search results to another object in the platform. As you

enter the related object, ThreatQ offers type-ahead suggestions.

9. Optionally, update the object's expiration policy, by choosing an option from the

Update Expiration Policy drop down menu.

10. Click Apply Changes.

Finding Items By Object Type

To find items by object type, you can use the Advanced Search feature from the main menu

or select an object from the Threat Library menu. From here, add keywords or filters to fine-

tune the search results.
Procedure
From the main menu, select Threat Library > [Your Desired Object Type].

The Advanced Search results page appears.

Wildcards and Symbols in Searches

During a search, you may use a percent sign (%) to match characters in a string. The percent
wildcard specifies that any characters can appear in multiple positions represented by the

wildcard. For example, specifying net% matches network, netware, netscape, and so on.
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Here are a number of examples showing search terms with percent wildcards:

Description

% panda Finds any adversaries and indicators with <name> panda

%ear Finds any character string that ends with "ear," such as bear

%panda%  Finds any character string that has panda in any position

panda% Finds any character string that begins with panda

Finds any character string that has pan in the first three positions and
pan%a _
ends with an "a"
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Indicators

Within this section, the following options are available:

o Viewing Indicators

« Indicators Overview Page

o Network Indicators Page

o Host Indicators Page

Adding an Indicator

1. Click on the Create button, located at the top of the dashboard and select

Indicator.

"l

You can also select Indicator Parser from the Create menu ifimporting a
file. The option is located under the Import section of the Create menu.
See the Import an Indicator Parser topic.

The Add Indicators dialog box will open.

2. Enter a value in the Value field.
3. Select the Type of Indicator.

4. Select a Source from the provided dropdown menu.

"l

You can also click on Add a New Source if the desired source is not
listed in the dropdown menu

5. Select a Status for the indicator.

6. Click on Add Indicator.
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Import an Indicator Parser

1. Click on the Create button, located at the top of the dashboard and select Indicator

Parser under the Import heading.

You can also click on Create > Indicator and then select the Parse
for Indicators option at the top of the Add Indicators modal.

The Add Indicators modal will load.

2. Do one of the following:
« Drag yourfile(s) into the left pane.
« Click on Click to Browse, and locate the file you wish to upload.
« Copy/paste the contentin the right pane.

3. Select the Parser to use and click on Next Step.

4. Selectwhether to save or delete the file after the import.

Steps 5-7 pertain to saving the file. Skip to step 8 if you are not sav-
ing the file after import.

Update the File Title if needed.
Enter an optional File Description.

Confirm or update the File Category.

© N o O

Select a Source from the dropdown menu provided.

You can also click on Add a New Source if the desired source is not
listed in the dropdown menu

10. Select a Status to be applied to the extracted indicators.

ThreatQ User Guide, Version 4.10 93



THREA TQH Indicators

11. Select any optional Attributes to be applied.
12. Click on Next Step.

-

G If the file contains events that are detected, the Step 2: Review
Events page opens. Indicators may be new or pre-existing. Pre-exist-
ing indicators are identified by a badge within the table. You can isol-
ate new and pre-existing indicators by using the tabs at the top of the
right hand panel.

13. Locate and select one or more indicators using one of the following options:
« From within the contents (on the left)
« From the table (on the right)
« By using the Select dropdown menu
14. Once you have selected one or more indicators, you can perform these functions:

1. Add Info - Click the Add Info button to open the Add Info dialog box where you

can perform the following functions:

« Add Attributes to the indicator: add one or more attributes to the selected

indicator(s). Once completed, click Add Attributes.

« Link to Another Object: Link the selected indicator(s) to another object

(indicator, event, adversary, file) and click Link Object.
« Set Status: Select a status and click Set Status.

2. Edit the type or status of an indicator by clicking its type or status in the table and

selecting an option from the dropdown menu.

3. Add Indicator - If you notice an indicator on the left that was not extracted, you
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can add it by clicking Add Indicator and completing the process.

4. If you want to search within the table, use the fields at the top of the columns.

G\ If at any point, you wish to abandon the import, click x ABANDON THIS
IMPORT.

15. Click on Finish Import.

The Indicators Overview page auto-refreshes with the new indicators added to the data, and

a confirmation alert appears in an alert bar at the top of the page.

.CSV File Format for Proper Parsing

When importing a .csv file to parse for indicators using the ThreatQ CSV File Parser, the .csv

file must meet the following criteria:

« The file must be comma-delimited.
« The file mustinclude at least the following columns:
o Indicator

o Type:This column cannot contain types that are not already established in
ThreatQ. You cannot add custom indicator types and indicator types are case

sensitive. Choose from the following:
. CIDR Block
« CVE
» Email Address
« Email Attachment
« Email Subject
« File Path
» Filename

« FQDN
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o Fuzzy Hash
o GOST Hash
» IP Address
« MD5

o Mutex

» Password
« Registry Key
« SHA-1

« SHA-256

« SHA-384

o SHA-512

« String

. URL

« URL Path

« User-agent
o Username
o X-Mailer

o Status

If the file is not properly delimited, missing a required column, or containing a valid type, it

will fail upon upload.

Viewing Indicators
There are three ways to access a list of indicators:

« Indicators Overview Page

o Network Indicators Page
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o Host Indicators Page

Indicators Overview Page

This page provides an insight into what indicators have been added to the system within the

last 15 days, as well as an overview of how many indicators fall under each indicator type.
Within this section, the following options are available:

« Accessing the Indicators Overview Page

« Indicators Overview Page: Information and Functions

Accessing the Indicators Overview Page

1. In the navigation menu, choose Analytics > Indicators.

2. The Indicators Overview page opens.
Indicators Overview Page: Information and Functions
The Indicators Overview page consists of three sections:

« Recently Created Indicators histogram

« Recently Created Indicators Summary table

« Most Recent 100 Indicators table

Recently Created Indicators histogram

The histogram is organized by date. Daily indicator totals are at the top of each column.
Each bar is broken down into colors, one for each indicator type. The following functions are

available:
« Viewing the number of indicators created each day by type

Hover over a colored section to view a popup showing how many attempts of a par-
ticular type (for example, MD5, SHA-1, SHA-256) were made on that date.
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« Zooming in for a closer view
Drag your mouse over a section of the histogram, and your view will be magnified.
Click Reset Zoom to return to the full histogram.

« Printing the histogram or downloading it as a PNG, JPEG, PDF, or SVG file

Click the hamburger menu (see graphic below), and select the desired option.

Recently Created Indicators Summary table

Immediately below the histogram is a summary table, showing you indicator totals by status,

network, and host. The following functions are available:
« Sorting the table by a column

Click the column header. To reverse the column sorting order, click the header a

second time.
« Conducting a search based on one of the criteria in the table
Click the desired criterion (a status, network, or host).
Most Recent 100 Indicators table

This table shows the 100 most recent indicators, the date and time they were created, and

their name, type, status, and sources. The following functions are available:

« Changing the number of entries displayed in the table

Click the dropdown menu at the top right of the table and select the desired option.

« Sorting the table by a column
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Click the column header. To reverse the column sorting order, click the header a

second time.

« Searching within a column

Click within the search box at the top of the column, and enter your search criteria.

« Accessing the Indicator Details page for one of the indicators

Click an indicator to access the Indicator Details page.

Network Indicators Page

This page provides an overview of how many and which types of indicators were added to
the system within the last 15 days, as well as supporting information related to them. Within

this section, the following options are available:

o Accessing the Network Indicators Page

o Network Indicators Page Information & Functions

Accessing the Network Indicators Page

« In the navigation menu, choose Analytics > Network Indicators and then choose
the Network tab.

The Network Indicators page opens.
Network Indicators Page Information & Functions
The Network Indicators page consists of the following sections:

Recently Created Indicators histogram

Recently Created Indicators Summary table

» Attributes pane

Recent Sources scatterplot
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o Attack Phases pie chart

« Indicators By Type pie chart

Recently Created Indicators histogram

The histogram is organized by date. Daily indicator totals are at the top of each column.
Each bar is broken down into colors, one for each indicator type. The following functions are

available:
« Viewing the number of indicators created each day by type

Hover over a colored section to view a popup showing how many attempts of a par-
ticular type (for example, MD5, SHA-1, SHA-256) were made on that date.

« Zooming in for a closer view
Drag your mouse over a section of the histogram, and your view will be magnified.
Click Reset Zoom to return to the full histogram.

« Printing the histogram or downloading it as a PNG, JPEG, PDF, or SVG file

Click the hamburger menu (see graphic below), and select the desired option.

Summary Table

Immediately below the histogram is a summary table, showing you a breakdown of indic-
ators by date, name, type (network/host), status, and sources. The following functions are

available:
« Changing the number of entries displayed in the table

Click the dropdown menu at the top right of the table and select the desired option
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« Sorting the table by a column

Click the column header. To reverse the column sorting order, click the header a

second time.
» Searching within a column
Click within the search box at the top of the column, and enter your search criteria.
« Accessing the Indicator details page for one of the listed indicators
Click the indicator to open the Indicator Details page.
Attributes pane

The attributes pane helps provide insight into trends of attribute values and keys. Analysts
are able to see which attribute keys they have the most information for, and use that inform-

ation to look for trends. The attributes pane is made up of a number of areas:

o Recently Created Indicators Attributes List

o Accessed Time Top 10 Values Circle Graph

« Indicator Values List

Recently Created Indicators Attributes List

The attributes list on the left side lists attributes related to indicators in your system and gives

you ways to access more information about them. The following functions are available:

« Changing the number of entries displayed in the table

Click the dropdown menu at the top right of the table and select the desired option.

« Searching within a column

Click within the search box at the top of the column, and enter your search criteria.

» Viewing more information about a selected attribute
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Select the row/attribute in the table, and additional information will populate the right

side.

Accessed Time Top 10 Values Circle Graph

ATTRIBUTES

Select an attribute below:
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|
| |
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|
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>
>
Downloaded At o >
Executed At [

>

Filename 0 Showing 1 to 10 of 3,590 entries Show( 10 ¢ entries
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Once an attribute has been selected, and the right side is populated, this circle graph is

accessible. The following functions are available:

« Viewing more information about a selected value

Hover over a colored section of the circle graph to open a popup identifying the attrib-

ute name and how different indicators contain the exact attribute.

« Hiding or unhiding one of the values from the circle graph

Click the value on the right of the circle graph to remove it from the graph; click a

second time to reinstate it.

« Printing the circle graph or downloading it as a PNG, JPEG, PDF, or SVG file
Click the hamburger menu (see graphic below), and select the desired option.
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Indicator Values List

This table lists each value and the number of related indicators. The following functions are

available:

« Changing the number of entries displayed in the table

Click the dropdown menu at the top right of the table and select the desired option.

« Conducting an indicator search based on one of the values

Click the value to open the Indicator Search tool.

For more information on using the advanced search tool, see Performing an Indic-

ator Search.

Recent Sources scatterplot
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This scatterplot shows how many indicators were provided by a given source each day

within a specified timeframe. The following functions are available:
« Viewing the date and number of indicators from a given source

Hover over one of the circles to open a popup with this information.
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« Adjusting the timeframe of the information displayed
Click the dropdown menu at the top right and select the desired timeframe.
« Hiding or unhiding one of the values from the scatterplot
Click the source in the legend under the scatterplot to hide it. Click again to unhide it.

Attack Phases pie chart

Attack phases are the ways an indicator might be used. They are listed as indicator attrib-
utes. This pie chart shows the number of indicators that fall under each attack phase. The fol-

lowing functions are available:
« Viewing the number of indicators with a given attack phase
Hover over one of the sections of the pie chart to open a popup with this information.
« Adjusting the timeframe of the information displayed
Click the dropdown menu at the top right and select the desired timeframe.
 Hiding or unhiding one of the values from the pie chart
Click the source in the legend to hide it. Click again to unhide it.

Indicators By Type pie chart

This pie chart shows you the number of indicators by type. The outer ring displays indicators

in review, and the inner ring shows totals. The following functions are available:
« Viewing the number of indicators of a given type
Hover over one of the sections of the pie chart to open a popup with this information.
« Adjusting the timeframe of the information displayed

Click the dropdown menu at the top right and select the desired timeframe.
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« Hiding or unhiding one of the values from the pie chart

Click the type in the legend to hide it. Click again to unhide it.

Host Indicators Page

The Host Indicators page provides an overview of how many and which types of indicators
were added to the system within the last 15 days, as well as supporting information related

to them. Within this section, the following options are available:

o Accessing the Host Indicators Page

o Host Indicators Page: Information & Functions

Accessing the Host Indicators Page

« In the navigation menu, choose Analytics > Indicators and then choose Host.

The Host Indicators page opens.
Host Indicators Page: Information & Functions
The Host Indicators page consists of the following sections:

o Recently Created Indicators histogram

« Host Indicators Summary table

« Host Indicators Attributes pane

« Host Indicators Recent Sources scatterplot

o Host Indicators Attack Phases pie chart

o Host Indicators Summary table

Recently Created Indicators histogram

The histogram is organized by date. Daily indicator totals are at the top of each column.

Each bar is broken down into colors, one for each indicator type. The following functions are
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available:
« Viewing the number of indicators created each day by type

Hover over a colored section to view a popup showing how many attempts of a par-

ticular type (for example, MD5, SHA-1, SHA-256) were made on that date.

« Zooming in for a closer view
Drag your mouse over a section of the histogram, and your view will be magnified.
Click Reset Zoom to return to the full histogram.

« Printing the histogram or downloading it as a PNG, JPEG, PDF, or SVG file

Click the hamburger menu (see graphic below), and select the desired option.

Host Indicators Summary table

Immediately below the histogram is a summary table, showing you a breakdown of indic-
ators by date, name, type (network/host), status, and sources. The following functions are

available:
« Changing the number of entries displayed in the table
Click the dropdown menu at the top right of the table and select the desired option.

« Sorting the table by a column

Click the column header. To reverse the column sorting order, click the header a

second time.

« Searching within a column

Click within the search box at the top of the column, and enter your search criteria.
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Host Indicators Attributes pane

The attributes pane helps provide insight into trends of attribute values and keys. Analysts
are able to see which attribute keys they have the most information for, and use that inform-

ation to look for trends. The attributes pane is made up of a number of areas:

« Host Indicators Attributes List

o Host Indicators Accessed Time Top 10 Values Circle Graph

« Host Indicators Values List

Host Indicators Attributes List

The attributes list on the left side lists attributes related to indicators in your system and gives

you ways to access more information about them. The following functions are available:
« Changing the number of entries displayed in the table
Click the dropdown menu at the top right of the table and select the desired option.
« Searching within a column
Click within the search box at the top of the column, and enter your search criteria.
« Viewing more information about a selected attribute

Select the row/attribute in the table, and additional information will populate the right

side.
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Host Indicators Accessed Time Top 10 Values Circle Graph
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Once an attribute has been selected, and the right side is populated, this circle graph is

accessible. The following functions are available:

« Viewing more information about a selected value

Hover over a colored section of the circle graph to open a popup identifying the attrib-

ute name and how different indicators contain that exact attribute.

« Hiding or unhiding one of the values from the circle graph

Click the value on the right of the circle graph to remove it from the graph; click a

second time to reinstate it.

« Printing the circle graph or downloading it as a PNG, JPEG, PDF, or SVG file
Click the hamburger menu (see graphic below), and select the desired option.
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Host Indicators Values List

This table lists each value and the number of related indicators. The following functions are

available:

« Changing the number of entries displayed in the table

Click the dropdown menu at the top right of the table and select the desired option.

« Conducting an indicator search based on one of the values

Click the value to open the Indicator Search tool.

For more information on using the advanced search tool, see Performing an Indic-

ator Search.

Host Indicators Recent Sources scatterplot
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This scatterplot shows how many indicators were provided by a given source each day

within a specified timeframe. The following functions are available:

« Viewing the date and number of indicators from a given source

Hover over one of the circles to open a popup with this information.

ThreatQ User Guide, Version 4.10 109



THREA Tﬂf* Indicators

« Adjusting the timeframe of the information displayed

Click the dropdown menu at the top right and select the desired timeframe.
« Hiding or unhiding one of the values from the scatterplot
Click the source in the legend under the scatterplot to hide it. Click again to unhide it.
Host Indicators Attack Phases pie chart

Attack phases are the ways an indicator might be used. They are listed as indicator attrib-
utes. This pie chart shows the number of indicators that fall under each attack phase. The fol-

lowing functions are available:
« Viewing the number of indicators with a given attack phase
Hover over one of the sections of the pie chart to open a popup with this information.
« Adjusting the timeframe of the information displayed
Click the dropdown menu at the top right and select the desired timeframe
« Hiding or unhiding one of the values from the pie chart
Click the source in the legend to hide it. Click again to unhide it.
Host Indicators By Type pie chart

This pie chart shows you the number of indicators by type. The outer ring displays indicators

in review, and the inner ring shows totals. The following functions are available:
« Viewing the number of indicators of a given type
Hover over one of the sections of the pie chart to open a popup with this information.
« Adjusting the timeframe of the information displayed

Click the dropdown menu at the top right and select the desired timeframe.
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« Hiding or unhiding one of the values from the pie chart

Click the type in the legend to hide it.

Indicator Details Page
Within this section, the following options are available:

o Accessing the Indicator Details Page for a Particular Indicator

o Indicator Details Page: Information & Functions

Accessing the Indicator Details Page for a Particular Indicator

« Locate and click the indicator.

The Indicator Details page opens.

Indicator Details header

THREA TQ ” Indicators * Events Adversaries Files Q - 24

39B6D40906C7F7FO80E6BEFA99382DDDADCBDIFA sraTLs: (o s

SHA-1

@ Delete This Indicator

At the top of the Indicator Details page is a header with the indicator value, date created,

type, and status.
The following functions are available:

Editing the Value of an Indicator

Changing the Type Associated with an Indicator

Changing the Status of an Indicator

Deleting an Indicator
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Indicator Details Summary Page: Information & Functions

The Indicator Details Summary page consists of five sections:

Details pane

Related Adversaries pane

Related Events pane

Related Files pane

Related Indicators pane

Details pane

< Add Attribute

Attributes (2)

Source http:www.secureworks.com/cyber-threat-intelligence/threats/dugu/ 091515

Indicator Role c2 09/15/15

Sources (1)

ThreatQA 0971515

This pane provides information about the attributes and sources of the Indicator, including

the name and date created. The following functions can be performed:

o Adding an Attribute to an Indicator

« Deleting an Attribute from an Indicator

Performing a search for a listed attribute

Click the attribute to set it as a search criterion and open the Advanced Search page.
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For more information on using the advanced search tool, see Performing an Indicator

Search.

Related Adversaries pane

RELATED ADVERSARIES

CROUCHING TIGER 75%) ~

by Threat Quotient (09/15/15)

Confidence

Comments (1)

Threat Quotient (09/15/15 11:24 am)

Based on my research | can say this looks like crouching tiger.

edit delete

Add a Comment

This pane provides information about adversaries related to the indicator, including the

name and date created, and the confidence level. The following functions are available:

o Linking an Adversary to an Indicator

« Unlinking an Adversary from an Indicator

« Editing the Confidence Level of an Adversary Related to an Indicator

« Adding a Comment to an Adversary Related to an Indicator

o Viewing a Comment for an Adversary Related to an Indicator

o Editing a Comment for an Adversary Related to an Indicator

o Deleting a Comment for an Adversary Related to an Indicator

For more information on one of the functions, click the function.
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Related Events pane

This pane provides information about events related to the indicator, including the date and

type of the event. The following functions are available:
« Sorting the list by date or type
Use the dropdown menu.

o Linking an Event to an Indicator

« Unlinking an Event from an Indicator

Related Files pane

RELATED FILES Gy LinkFile | $3 Unlink

zz_threatqa fileQ2.pdf Threat Quotient

This pane provides information about files related to the indicator, including the name and

the date the file was created. The following functions are available:

« Linking a File to an Indicator

Unlinking a File from an Indicator

Accessing the File Details page of a related file

Click the File name.

Downloading a related file

Click the download icon.
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Related Indicators pane

RELATED INDICATORS G Link Indicator |~ S35 Unlink

Sort: | Date of Indicator Creation %

08/29/15

212,227.89.182 IP Address
78.47.182.219 IP Address
78.47.182.222 IP Address
115.182.88.152 IP Address

115.182.90.221 IP Address

This pane provides information about indicators related to the indicator, including the name
of the related indicator, its date created, its type, and its status. The following functions are

available.

Linking a File to an Indicator

o Unlinking a File from an Indicator

« Sorting the list by date of creation or type
Use the dropdown menu

« Accessing the Indicator details page for one of the related indicators
Click the indicator name.

For more information, Accessing the Indicator Details Page for a Particular Indicator

and Indicator Details Page: Information & Functions.
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Indicator Details History Page: Information & Functions
The Indicator Details History page consists of one section:
» History pane
History pane
This pane provides a history of the indicator. The following function is available:
« Show or hide details
Click the appropriate link
Indicator Details Data Enrichment Page: Information & Functions

The sidebar lists the different tools available within ThreatQ. Click a tool on the left to send
the indicator to that tool in order to see if it has any information about the indicator. Results

will be displayed in a table on the right. The following functions are available:
« Sending the indicator out to one of the listed tools
Click the tool on the left. Any results will populate a table on the right.

Any returned indicators can be added to ThreatQ and automatically linked to the indic-

ator submitted.

Indicator Details Page: Procedures

Within this section is a comprehensive set of procedures found on the Indicator Details

page. The following options are available:

o Editing the Value of an Indicator

o Changing the Type Associated with an Indicator

o Changing the Status of an Indicator
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Whitelisting a CIDR Block Indicator

Deleting an Indicator

Adding an Attribute to an Indicator

Deleting an Attribute from an Indicator

Searching by Attribute

Linking an Adversary to an Indicator

Unlinking an Adversary from an Indicator

Editing the Confidence Level of an Adversary Related to an Indicator

Adding a Comment to an Adversary Related to an Indicator

Viewing a Comment for an Adversary Related to an Indicator

Editing a Comment for an Adversary Related to an Indicator

Deleting a Comment for an Adversary Related to an Indicator

Linking an Event to an Indicator

Unlinking an Event from an Indicator

Linking a File to an Indicator

Unlinking a File from an Indicator

Linking an Indicator to another Indicator

Unlinking an Indicator from another Indicator

Editing the Value of an Indicator

To edit the value of an indicator

1.

Locate and click the indicator.

The Indicator Details page opens.

2 Click the editicon ( )-
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3. An Edit Indicator window will pop up. Change the indicator value and/or indicator

type and click the “Save Indicator” button.

An indicator updated confirmation alert appears in an alert bar at the top of the page.

Changing the Type Associated with an Indicator

There are a number of types of indicators, such as CIDR Block, Email Address, Filename,
FQDN.

To change the type associated with an indicator:

1. Locate and click the indicator.

The Indicator Details page opens.

2. Click the indicator type dropdown menu, and select the desired type.

An Indicator updated confirmation alert appears in an alert bar at the top of the page.
Indicator Status
Every indicator in the system will have a status applied to it.

The default statuses that ship with a standard installation of ThreatQ are as follows:

Active - Poses a threat and is being exported to detection tools.

« Indirect - Associated to an active indicator or event (i.e. pDNS).

Review - Requires further analysis.

Whitelisted - Poses NO risk and should never be deployed.
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STATUS: Active +

Expired

Mo longer poses a serious threat.

Indirect
Associated to an active indicator or event (i.e. pDNS).

Review
Requires further analysis.

Whitelisted
Poses NO risk and should never be deployed.

Most exports in ThreatQ are configured to use the Active status to signal deployment to
external devices. However this can be modified and each status can be used however your

organization sees fit.
Changing the Status of an Indicator

Changing an indicator’s status is straightforward, except in the case of whitelisting CIDR
Block indicators. When whitelisting a CIDR Block indicator, this process generates a whitel-

isting rule. For more information, Changing the Status of an Indicator.

To change the status of an indicator:

1. Locate and click the indicator.

The Indicator Details page opens.

2. Click the status dropdown menu, and select the desired status.
The status will be updated, and a confirmation alert appears in an alert bar at the top of

the page.

If an Administrator or the Primary Contributor are whitelisting a CIDR BLOCK indic-
ator, there is a different process, as this actually generates a whitelisting rule. For more

information, see Whitelisting a CIDR Block Indicator below.
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Adding Custom Statuses

There are use cases where an organization would like to use their own statuses within

ThreatQ and we've set it up so that it's easily achievable.

First, as a ThreatQ admin, you'll need to go to the User dropdown (gear icon) in the top right
hand corner of the site and click on the System Configurations section.

ate New

My Account

ThreatQ Configuration

- User Management

- Incoming Feeds

- Whitelisted Indicators

" Exports
- Tools

 OAuth Management

System Configurations ‘h

= Log Out

Next you'll arrive on the Indicator Statuses page.
Here you'll see a list of Indicator Statuses with the following information:

o Status Name
« Description

« Total count of indicators associated with that status
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THREA TO ” Indicators ~ Events Adversaries Files o} O~ &

Indicator Statuses Indicator Types  EventTypes  Proxy

INDICATOR STATUSES

Statuses +  Description Total Indicators
Search Search

Active Poses a threat and is being exported to detection tools. 152,494

Expired No longer poses a serious threat 6

Indirect Associated to an active indicator or event (i.e. pDNS). 1,200,324

Review Requires further analysis. 0

Whitelisted Poses NO risk and should never be deployed. o

To add a new status click the "+ Add" button on the right side of the Indicator Statuses panel

header.

ADD A STATUS

Status Name

Status Description

You'll be asked to add the Status Name and Status Description. Only the Status Name is
required.

Whitelisting a CIDR Block Indicator

Whitelisting a CIDR Block indicator creates a whitelisting rule. This rule will be applied to

other indicators in the system, and any indicators added to ThreatQ henceforth.
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The process below explains how to whitelist a CIDR Block indicator from the Indicator
Details page for the indicator. A CIDR Block indicator can also be whitelisted via the tools

menu. For more information on this process, see Creating a Whitelist Rule.

To whitelist a CIDR Block indicator:

1. Locate the CIDR Block indicator you wish to create a whitelist rule for.
2. Access the Indicator Details page for the indicator.

3. Click the status dropdown, and select Whitelisted.

A confirmation dialog box opens asking if you are sure.

4. Click Whitelist Indicator.
The Add Whitelist Rule dialog box opens with type and value according to the CIDR
BLOCK indicator you chose to whitelist.

5. If you are satisfied with the type and value, click Next.

Affected indicators are listed in the dialog box.
6. Review the affected indicators to determine if you are satisfied with the rule.

The rule has not been applied yet, so you still have time to edit it based on whether

you are satisfied with how it affects the indicators.

7. Ifyou are satisfied with the rule, click Add Rule.
The rule is applied to existing indicators, and it is entered into the Whitelist Rules
table.

Deleting an Indicator
To delete an indicator:
1. Locate and click the indicator.

The Indicator Details page opens.
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2. Click the Delete This Indicator button.

A wamning dialog appears.
Once an indicator has been deleted, this cannot be undone.
3. To proceed, click Delete Indicator.

The Indicators Overview page refreshes, and a confirmation alert appears in an alert

bar at the top of the page.
Adding an Attribute to an Indicator
To add an attribute to an indicator
1. Locate and click the indicator.
The Indicator Details page opens.
2. In the Details pane, click + Add Attribute.
The Add Attributes dialog box opens.
3. Inthe Add Attributes dialog box, specify the Attribute Name and Attribute Value.

When you click within the Attribute Name field, a dropdown menu opens.
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ADD ATTRIBUTES

Attribute Name ‘ Attribute Value

Source Type

Malware Family

MD5

Port

SHA-1
PhishTank 1D
CIDR Block
IP Address
URL

Target
Confidence

Source

4. Click +.

5. Once you have added all desired attributes, click Add Attributes.
The attribute(s) are added, and a confirmation alert appears in an alert bar at the top of

the page.
Deleting an Attribute from an Indicator
To delete an attribute from an indicator:
1. Locate and click the indicator.
The Indicator Details page opens.
2. Inthe Details pane, select the attribute(s) you wish to delete.
Click Delete.

A confirmation dialog box will open asking if you are sure.
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3. Click Delete Attribute.

The attribute(s) are deleted, and a confirmation alert appears in an alert bar at the top

of the page.

Searching by Attribute
To search by attribute
1. Locate and click the indicator.
The Indicator Details page opens.
2. In the Details pane, click the Attribute you wish to search for.
The Indicator Search window opens.
3. Review search formatting and add any other search criteria.

4. Click Search.
A results table appears below the search pane.

Linking an Adversary to an Indicator
To link an adversary to an indicator
1. Locate and click the indicator.
The Indicator Details page opens.
2. In the Related Adversaries pane, click Link Adversary.

The Link an Adversary dialog box opens.
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LINK AN ADVERSARY

Q

Comment

3. Type the name of the adversary into the search tool.
Search results appear immediately below.
4. Selectone or more adversary names from the results.

5. (Optional) Add a comment.

6. Click Link Adversary.
The adversary is linked, and a confirmation alert appears in an alert bar at the top of

the page.
Unlinking an Adversary from an Indicator
To unlink an adversary from an indicator
1. Locate and click the indicator.
The Indicator Details page opens.
2. Inthe Related Adversaries pane, select one or more adversaries you wish to unlink.

3. Click Unlink.
A confirmation dialog box will open asking if you are sure.
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4. Click Unlink Adversary.

The adversary is unlinked, and a confirmation alert appears in an alert bar at the top of

the page.
Editing the Confidence Level of an Adversary Related to an Indicator
The confidence level can be setto 0, 25, 50, 75, and 100.
To edit the confidence level of an adversary related to an indicator
1. Locate and click the indicator to which the adversary is related.
The Indicator Details page opens.

2. In the Related Adversaries pane, click the dropdown arrow to the right of the

adversary, and slide the scale to the desired confidence level.

The displayed confidence level will be modified to reflect your selection.

Adding a Comment to an Adversary Related to an Indicator

When you add a comment to a related adversary, the comment is attached to the indicator,

as it pertains to the indicator-adversary relationship, and not the adversary itself.
To add a comment to an adversary related to an indicator.
1. Locate and click the indicator the adversary is related to.
The Indicator Details page opens.

2. Inthe Related Adversaries pane, click within the Comments field, and type your com-

ment.

3. Click Add Comment.
The comment is added, and a confirmation alert appears in an alert bar at the top of

the page.
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Viewing a Comment for an Adversary Related to an Indicator

To view a comment for an adversary related to an indicator:

1.

Locate and click the indicator the adversary is related to.

The Indicator Details page opens.

. Inthe Related Adversaries pane, locate the comment you wish to view.

Click the arrow to the right of the comment row.

The comment field appears.

Editing a Comment for an Adversary Related to an Indicator

To edita comment for an adversary related to an indicator

1.

Locate and click the indicator the adversary is related to.

The Indicator Details page opens.

In the Related Adversaries pane, locate the comment you wish to edit.
You can only edit comments you made.

Click the arrow at the right of the comment row to expand it.

. Click Edit.

The comment field appears.
Make the desired edits.

Click Update Comment.
The comment is updated, and a confirmation alert appears in an alert bar at the top of

the page.

Deleting a Comment for an Adversary Related to an Indicator

To delete a comment for an adversary related to an indicator:
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1. Locate and click the indicator the adversary is related to.
The Indicator Details page opens.

2. In the Related Adversaries pane, locate the comment you wish to delete.
You can only delete comments you made.

3. Click the arrow at the right of the comment row to expand it.

4. Click Delete.

A warning dialog box opens asking if you are sure.
5. Click Delete Comment.

The comment is deleted, and a confirmation alert appears in an alert bar at the top of

the page.
Linking an Event to an Indicator
To link an event to an indicator:
1. Locate and click the indicator.
The Indicator Details page opens.
2. In the Related Events pane, click Link Event.
The Link an Event dialog box opens.
3. Type the name of the event you wish to link.

The system will provide typeahead suggestions, if any, based on what you have

typed.

4. Select the event from the list.

5. Click Link Event.
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The eventis linked, and a confirmation alert appears in an alert bar at the top of the

page.
Unlinking an Event from an Indicator
To unlink an event from an indicator:
1. Locate and click the indicator.
The Indicator Details page opens.
2. Inthe Related Events pane, select the event(s) you wish to unlink.

3. Click Unlink.
A warning dialog box opens asking if you are sure.

4. Click Unlink Event.

The event(s) are unlinked, and a confirmation alert appears in an alert bar at the top of

the page.
Linking a File to an Indicator
To link a file to an indicator:
1. Locate and click the indicator.
The Indicator Details page opens.
2. Inthe Related Files pane, click Link File.
The Link Files dialog box opens.
3. Type the filename in the search field.

The system will provide typeahead suggestions, if any, based on what you have

typed.
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. Select the desired file from the options.

Click Link File.
The file will now be linked to the indicator in two places: on the Indicator Details page

under Related Files; and on the File Details page for the file, under Related Indicators.

Unlinking a File from an Indicator

To unlink a file from an indicator:

1.

Locate and click the indicator.
The Indicator Details page opens.
In the Related Files pane, select the file(s) you wish to unlink.

Click Unlink.
A warning dialog box opens asking if you are sure.

Click Unlink File.

The file(s) will be unlinked, and a confirmation alert appears in an alert bar at the top of

the page.

Linking an Indicator to another Indicator

To link an indicator to another indicator:

. Locate and click the indicator you wish to link another indicator to.

The Indicator Details page opens.
In the Related Indicators pane, click Link Indicator.

The Link an Indicator dialog box opens.
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3. Type the name of the indicator you wish to link.

The system will provide typeahead suggestions, if any, based on what you have
typed.

Select the indicator(s) you wish to link.

Click Link Indicator.
The selected indicator(s) are linked, and a confirmation alert appears in an alert bar at

the top of the page.

Unlinking an Indicator from another Indicator

To unlink an indicator from another indicator:

1.

Locate and click the indicator you wish to unlink another indicator from.
The Indicator Details page opens.
In the Related Indicators pane, select one or more indicators you wish to unlink.

Click Unlink.
A warning dialog box opens asking if you are sure.

. Click Unlink Indicator.

The indicator is unlinked, and a confirmation alert appears in an alert bar at the top

of the page.

Whitelisted Indicators

There are some indicators that should be considered to be whitelisted, or non-malicious,

and we do not want those indicators going out to other systems. For example, a company’s

own domain name would never need to be blocked.
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The whitelisting process creates rules that apply to particular indicators, so that when those

indicators come in in the future, they will be automatically whitelisted.
Within this section, the following options are available:

Viewing Existing Whitelist Rules

Creating a Whitelist Rule

Editing a Whitelist Rule

Removing a Whitelist Rule

Viewing Existing Whitelist Rules
To view existing whitelist rules:
1. Go to ThreatQ Configuration > Whitelisted Indicators.

The Whitelist Rules page opens. Existing whitelist rules are listed in the Whitelist

Rules table.

Creating a Whitelist Rule

The process of creating a whitelist rule is almost exclusively available via the Tools menu.
However, itis important to note that whitelisting a CIDR Block indicator also creates a whitel-

istrule.
To create a whitelist rule:
1. Go to ThreatQ Configuration > Whitelisted Indicators.
The Whitelist Rules page opens.
2. Click Add Rule.

The Add Whitelist Rules page opens.
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ADD WHITELIST RULE

Which indicator type will this rule apply to?

CIDR Block

Rule Value

3. Select the Indicator type the rule will apply to.
4. Add a Rule Value.

5. Click Next.

Affected indicators are listed in the dialog box.
6. Review the affected indicators to determine if you are satisfied with the rule.

The rule has not been applied yet, so you still have time to edit it based on whether
you are satisfied with how it affects the indicators. To continue editing, click Continue
Editing this Rule.

7. If you are satisfied with the rule, click Add Rule.

The rule is applied to existing indicators, and itis entered into the Whitelist Rules
table.

Any new indicators will also have the rule applied to them as they enter the system.
Editing a Whitelist Rule

When you edit a whitelist rule, the changes you make will affect indicators currently in the

system, and any new indicators added to the system.
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Important: Editing a whitelist rule will not undo any changes the rule had made prior to

being edited.
To edit a whitelist rule:
1. Go to ThreatQ Configuration > Whitelisted Indicators.
The Whitelist Rules page opens.
2. In the Whitelist Rules table, locate the rule you wish to edit.

3. Click edit.
The Edit Whitelist Rule dialog box opens.

4. Make the desired edits and click Next.
Affected indicators are listed in the dialog box.
5. Review the affected indicators to determine if you are satisfied with the rule.

The rule has not been applied yet, so you still have time to edit it based on whether

you are satisfied with how it affects the indicators.
6. If you are satisfied, click Edit Rule.
The rule is applied to existing indicators, and itis updated in the Whitelist Rules table.
Any new indicators will also have the rule applied to them as they enter the system.
Removing a Whitelist Rule
To remove a whitelist rule:
1. Go to ThreatQ Configuration > Whitelisted Indicators.
The Whitelist Rules page opens.

2. In the Whitelist Rules table, locate and select the rule(s) you wish to remove.
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3. Click Remove.
A confirmation dialog box opens, asking if you are sure.

4. Ifyou are sure, click Delete Whitelist Rule.

The rule is deleted and a confirmation alert appears in an alert bar at the top of the

page.

Indicator Expiration

Expiration ("Expired") is a status that can be assigned to an indicator. The expired status
should be used when an indicator is deemed by an analyst to pose less of a threat to their

infrastructure than other indicators.

Ways an indicator can expire:

- An analyst manually changes an indicator(s) status to "Expired"

This can be achieved by visiting an individual indicator's details page, then using the

Status dropdown in the top right hand comer of the page to change the status.

If the analyst wishes to change the status of multiple indicators at the same time, they
can use the advanced search tool to find the indicators they'd like to update, then click

the Bulk Update button found directly to the right above the search results.
- An analyst manually sets an expiration date for a specific indicator

Each indicator has the option to have an expiration date set, which once past, will

toggle the status of that indicator from it's current status to "Expired".

« An expiration policy has been applied to the source reporting an indicator and
therefore an expiration date is automatically set for that indicator during inges-

tion
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Using the “Expiration” tab on the Indicator Management page, a ThreatQ admin has

the ability to apply expiration policies to all ingested information, both new and exist-

ing, coming from a specific intelligence source.

ﬂ If an indicator is reported by multiple sources that have expiration policies,
the date will be set using the greater expiration date. For example, if both
Feed A (with a 5 day policy) and Feed B (with a 3 day policy) report the
same indicator on the same day, that indicator will automatically expire 5
days from now.

Changing an individual indicator's expiration date

An indicator's expiration information can be found on the black bar directly below the indic-

ator's value on the indicator details page.

85.35.129.235

IP ADDRESS

Expiration Date Displays

« No expiration date has been set

In the example above, this particular indicator will not automatically expire because an

expiration date has not been specified.

This status will be changed if an analyst sets an expiration date or a new source (with

an expiration policy applied to it) reports this indicator in the future.
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« An expiration date is set

In the example above, this particular indicator has an expiration date set of 1/20/2017.
This means that this indicator will expire when the calendar day changes from the 19th

to the 20th of January (based on ThreatQ's server time, not the user's local time).

When an expiration date is less than 7 days away, ThreatQ will switch to show a rel-

ative version of the date.

« Protected from automatic expiration (Never Expire)

Never Expire (change)

Sometimes an analyst will want an indicator to stay "Active" regardless of any auto-
mated circumstances. In this case you can set an indicator to be protected from auto-
expiration, which will display the words "Never Expire". This can only be "overwritten"

by an analyst.

Changing an indicator's expiration date

When viewing a specific indicator, its expiration date can be changed by clicking on the link

next to the expiration information.
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Expires in 7 days {extend}

Add 7 days

Add 14 days
Protect from auto-expiration

Hemove current expiration date

Options include:
- Add 7 days
This will extend the current expiration date by 7 days.
. Add 14 days
This will extend the current expiration date by 14 days.
« Protect from auto-expiration

This will set the indicator to "Never Expire". Once set, this indicator will be exempt from
all automated expiration processes regardless of circumstances. The only way for this

indicator to expire moving forward is by analyst choice.
« Remove current expiration date

This will remove the currently set expiration date. If this indicator is reported by an intel-
ligence feed (with an expiration policy) in the future, a new expiration date will be

added at that pointin time.
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Automatic Expiration and Expiration Policies

Automatic expiration allows you to deprecate stale intelligence based on a set of defined cri-
teria. As the data becomes less relevant, the ThreatQ sets the status to Expired, which

relieves the data burden on your team or infrastructure.
Where can | configure Automatic Expiration?

From the navigation menu, choose the gear icon > Indicator Management > Automatic Expir-

ation.
Selecting an Expiration Policy per Feed

You can choose from three options when configuring an expiration policy for a source of

intelligence:
Don't automatically expire (No policy set)

ThreatQ sets all feeds to Don't Automatically Expire until an analyst decides otherwise.
When set, indicators reported from this specific feed do not have an expiration date auto-

matically applied to them.

If an indicator is reported by Source A (an intelligence feed without an expiration policy), and
is later reported by Source B (an intelligence feed that expires data in 7 days), ThreatQ sets

the indicators to automatically expire in 7 days.
Automatically Expire Indicators

When setting a specific intelligence feed to Automatically Expire Indicators, ThreatQ
requires you to provide a specific number of days. After you configure this setting, it applies
to all intelligence currently in the system, as well as new intelligence as itis ingested.
ThreatQ calculates the appropriate expiration date based on the number of days from inges-

tion. Once an indicator's expiration date is met, its status changes to Expired.

DeepSight Advanced URL Reputation CnC XML Feed Automatically Expire Indicators v Expire After 14  days after ingestion. Exceptions »
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Never Expire

Using this setting ensures that all intelligence reported by a specific feed is protected from

automatic expiration, regardless of scenario.
Adding Exceptions

In addition to setting an expiration policy at a global level for all intelligence ingested by a

specific feed, ThreatQ allows you to add exceptions based on specific indicator types.

To add an exception, while viewing the Automatic Expiration tab, choose a source and click

Exceptions to expand the option.

From here, you can add or remove exceptions to the policy listed above for that specific feed.

Alienvault OTX Automatically Expire Indicators 3 Expire After 14 days after ingestion. Exceptions ~

Exceptions
Indicator Type Policy

CIDR Block ] Expire 25 days after ingestion.

How ThreatQ Calculates Expiration Dates
Indicator Reported by Source with an Expiration Policy

If an indicator has an expiration date and it's reported by a new source that has an expiration

policy, ThreatQ will set the expiration date using the policy with the greater expiration date.
Indicator Report by a Source with an Expiration Policy of Never Expire

If an indicator has an expiration date and it's reported by a new source that has an expiration

policy of Never Expire, ThreatQ sets that indicator to Never Expire.
Indicator Reported by a Source with an Exception for that Indicator

If an indicator is reported by a source that has an exception for the indicator, the exception

expiration date will be used regardless of the greater expiration date.
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' . . c
‘ G An exception takes precedence over the source’s expire policy.

Indicator Reported by Two Different Sources

If an indicator is reported by a source an Expiration Policy and then reported by a second
source with another Expiration Policy, the greatest expiration date is selected to set the expir-
ation date. The expiration date will be set based on the date the second source reported the

indicator.
Indicator Reported by Two Different Sources, one with an Exception

If an indicator is reported by a source that has an exception for the indicator and then repor-
ted by a second source, the greatest expiration date is selected despite the exception. The

expiration date will be set based on the date the second source reported the indicator.
Common Expiration Policy scenarios
An indicator is reported by a single source (with an expiration policy)

1. On 10/1, Source A reports the indicator and the expiration date is setto 10/8.

2. When the date switches from 10/7 to 10/8, this indicator is queued to have its

status changed to Expired.

An indicator is reported by Source A (with an expiration policy of 7 days) and 3 days later
is reported by Source B (with an expiration policy of 10 days).

1. On 10/1, Source A reports the indicator and the expiration date is setto 10/8.

2. Source B reports the same indicator 3 days later (10/4). The indicator's expiration
date is set using the greatest expiration date between the two sources. In this
example, the new expiration date will be 10/14 (10 days from when it was reported

by Source B).

3. When the date switches from 10/14 to 10/15, this indicator is queued to have its

status changed to Expired.
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An indicator is reported by Source A (with an expiration policy of 7 days) and is later repor-

ted by Source B (with an expiration policy of Never Expire).

1. On 10/1, Source A reports the indicator and the expiration date is setto 7 days.

2. Source B reports the same indicator 3 days later with a policy of Never Expire. The
indicator’s expiration date is removed and the indicator is now set to Protect from

auto-expiration.

An indicator is currently set to Expired and is reported by Source A (with an expiration
policy of 7 days).
1. On 10/1, an indicator is in ThreatQ with a status of Expired.

2. On 10/1, Source A reports the indicator. The status of the indicator changes to

whatever the default status is for Source A and the expiration date is setto 10/8.

3. When the date switches from 10/7 to 10/8, this indicator is queued to have its

status changed to Expired.

An indicator is currently set to Expired and is reported by Source A (with an expiration
policy of Never Expire).

1. Anindicatoris in ThreatQ with a status of Expired.

2. Source A (with an expiration policy of Never Expire reports the indicator. The expir-

ation of that indicator changes to Protect from auto-expiration.

A FQDN indicator is reported by Source A (with an expiration policy of 10 days with an
exception for 5 days for FQDN indicators) and is later reported by Source B (with an expir-

ation policy of 15 days).

1. On 10/1, Source A reports the FQDN indicator and the expiration date is set to
10/6.

L3 . . c
G An exception takes precedence over the source’s expire policy. J
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2. Source B reports the same indicator 1 day later (10/2). The indicator's expiration

date is set using the greatest expiration date between the two sources. In this
example, the new expiration date will be 10/17 (15 days from when it was reported

by Source B).
3. When the date switches from 10/17 to 10/18, this indicator is queued to have its
status changed to Expired.

Applying Expiration Policy Changes to Existing Data

When updating an expiration policy, the system now applies the update to all selected
existing data in the platform to honor the new policy. This process can take a while based on

system resources and the number of indicators in the system.

Refer to the following table for estimates on the total time required for the system to apply the

selected policy to existing data, based on the following criteria:

« Dataset: 6 Million Indicators

» System Specifications: 32GB VM 4 vCPU

Indicators to reset
Reset and Recalculate

expiration out of 6m Expire Indicators Total Time for Reset
Expiration

total indicators

3 hours and 30 3 hours 31
50,000 . 53 seconds _

minutes minutes

4 hours and 51 4 hours 53
100,000 . 1.8 minutes _

minutes minutes

10 hours 20 10 hours 24
200,000 . 3.5 minutes _

minutes minutes
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Indicators to reset
expiration out of 6m

total indicators

Reset and Recalculate

Expire Indicators

Expiration

Total Time for Reset

1.2 million

3.1 million

5.3 million

Indicator Scoring

2 days 7 hours 4

. 35 minutes
minutes
3 days 16 hours
3.5 hours
42 minutes
4 days 7 hours 17
4.7 hours

minutes

2 days 7 hours 40

minutes

3 days 20 hours

4 days 12 hours

Indicator scoring allows you to apply weighting to indicators and their contextual information,

such as sources, attributes, and indicator types, as they are added to ThreatQ. Indicator scor-

ing allows you to set manual scores or you can rely on ThreatQ’s scoring algorithm to cal-

culate scores. After scores are calculated, you can change the score as desired to your

custom value or accept the calculated value.

Where can | configure Indicator Scoring

From the navigation menu, choose the gear icon > Indicator Management > Scoring.

Building a Scoring Algorithm

As you build a scoring algorithm, you influence indicator scores based on the following cri-

teria:

« Indicator Type

« Indicator Source
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o Attributes

« Adversary Relationship

Use the slider to determine the sensitivity of the criterion you select. By default, the slider is
positioned in neutral position, which in isolation produces an indicator score of zero. You
may increase the score up to 10, which creates a score of Very High. You may also

decrease the score, which creates a score of Very Low.

« Toinfluence scores based on attributes, you click Add and designate an Attribute

Key / Value Pair, before adjusting the sensitivity.

« Toinfluence scores based on adversary relationship, you click Add and select an

adversary, before adjusting the sensitivity.

Overriding the scoring algorithm with a manual score
To set a manual Indicator Score, complete the following steps:

1. Navigate to an Indicator's Details page.
2. Choose the Indicator Score.

3. Optionally, you may revert to the calculated score by choosing Generated Score.
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Events

Events are observations made by the threat intelligence community of adversaries’ mali-

cious attempts.
Within this section, the following options are available:

o Accessing the Events Overview page

o Events Page: Information & Functions

Adding an Event
To add an event:
1. Go to Create > Event.
The Add Event dialog box opens.

2. Select the Event Type.

3. Select a Source from the dropdown menu provided.

You can also click on Add a New Source if the desired source is not
listed in the dropdown menu

5. Add the date and time the event occurred in the Date of Occurrence fields.
6. Add an Event Title.
7. Click Add Event.

The Event Details page opens for the event, and a confirmation alert appears in an

alert bar at the top of the page.
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Accessing the Events Overview page

« In the navigation menu, choose Analytics > Events.

The Events Overview page opens.

Events Page: Information & Functions

The Events page provides a high-level view of what types of events have occurred and how

frequently they are occurring. There are four sections:

Events History scatter plot

o Event Details Summary Page

Monthly Heatmap table

Top Recipients of Spearphish table

Events History scatter plot

The scatter plot points are plotted by date (x-axis) and hour (y-axis). The legend under the
scatter plot identifies the different kinds of events shown. The following functions are avail-

able:
« Viewing an event’s name, date and time, and source

Hover your mouse over an event on the scatter plot to see its name, date and time, and

source.
« Opening the Event Details page for one of the events
Click the eventin the scatter plot.

For more information, see Event Details Page.

« Hiding or unhiding one or more of the event types

ThreatQ User Guide, Version 4.10 148



THREAT() AN Events

Click the event type in the legend immediately below the scatter plot to remove it from

the graph; click it again to reinstate it.
« Adjusting the timeframe of the information displayed
Click the dropdown menu at the top right and select the desired timeframe.
« Printing or downloading the scatter plot as a PNG, JPEG, PDF, or SVG file

Click the hamburger menu (see graphic below), and select the desired option.

Summary table

Immediately below the scatter plot is a summary table of that provides a breakdown of

events by date, type, title, and sources. The following functions are available:

« Opening the Event Details page for one of the events

Click the eventtitle.

For more information, see Event Details Page.

« Changing the number of entries displayed in the table

Click the dropdown menu at the top right of the table, and select the desired option.
« Sorting the table by a column

Click the column header. Click the header a second time to reverse sort order.
« Searching within a column

Click within the search box at the top of the column, and enter your search criteria.
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Monthly Heatmap table

The Monthly Heatmap table lists events that happened per adversary each month. Shading
of the monthly totals is used to allow you to quickly scan for patterns in the events and to

quickly detect events with higher monthly counts. The following functions are available:
« Viewing an event’s name and monthly count
Hover your mouse over an event on the heatmap to see its name and monthly count.
« Adjusting the timeframe of the information displayed
Click the dropdown menu at the top right and select the desired timeframe.
« Printing the graph or saving it as a PNG, JPEG, PDF, or SVG

Click the hamburger menu (see graphic below), and select the desired option.

Top Recipients of Spearphish table

As Spearphish attempts come into the system, they have recipients and possibly adversar-
ies. Certain recipients may have more spearphish attempts. The following functions are

available:
« Opening the Adversary Details page for one of the adversaries
Click the adversary name.

For more information, see Adversary Details Page.

« Changing the number of entries displayed in the table

Click the dropdown menu at the top right of the table, and select the desired option.
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« Sorting the table by a column
Click the column header. Click the header a second time to reverse sort order.
« Searching within a column

Click within the search box at the top of the column, and enter your search criteria.

Event Details Page
Within this section, the following options are available:

« Accessing the Event Details page for a Particular Event

« Event Details Page: Information & Functions

Accessing the Event Details page for a Particular Event
« Locate and click the event.

The Event Details page opens.

Event Details Page: Information & Functions
The Event Details page is made up of the following:

« Event Details Header

« Two sub-tabs

o Event Details Summary Page

o Event Details History Page

Event Details Header

At the top of the Event Details Summary page is a header with the event name, date and

time of the event, date and time created, and event type. The following functions are
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available:

« Editing the Event Value

o Changing the Type Assigned to an Event

o Deleting an Event

Event Details Summary Page

The Event Details Summary page provides a wide range of information and functions

related to an event and consists of five sections:

o Event Details pane

o Events Related Adversaries pane

o Events Related Files pane

o Events Related Indicators pane

o Events Spearphish Details pane

« The Spearphish Details pane only appears for Spearphish events.
Event Details pane

This pane provides information about the attributes and sources of the event, including the

name and date. The following functions can be performed:

« Adding an Attribute to an Event

« Deleting an Attribute from an Event

« Performing a search for a listed attribute
Click the attribute to set it as a search criterion and open the Advanced Search page.

For more information on using the advanced search tool, see Performing an Indicator

Search.
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Events Related Adversaries pane

RELATED ADVERSARIES S Link Adversary | 5 Unlink

CROUCHING TIGER 75%) ~
by Threat Quotient (09/15/15)

Confidence

Comments (1)

Threat Quotient (09/15/15 11:24 am)
Based on my research | can say this looks like crouching tiger.
edit delete

Add a Comment

This pane provides information about adversaries related to the event, including the name

and date created, and the confidence level. The following functions are available:

« Linking an Adversary to an Event

« Unlinking an Adversary from an Event

« Editing the Confidence Level Associated with a Related Adversary

« Adding a Comment to a Related Adversary

« Viewing a Comment for a Related Adversary

o Editing a Comment for a Related Adversary

o Deleting a Comment from a Related Adversary

Events Related Files pane

RELATED FILES Qo LinkFile | £ Unlink

zz_threatga_file02.pdf Threat Quotient
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This pane provides information about files related to the indicator, including the name and

the date the file was created. The following functions are available:_

o Linking a File to an Event

o Unlinking a File from an Event

« Accessing the File Details page of a related file
Click the File name.

« Downloading a related file
Click the download icon

Events Related Indicators pane

RELATED INDICATORS S Link Indicator S5 Unlink

Sort: | Date of Indicator Creation %

08/29/15

212.227.89.182 IP Address
78.47.182.219 IP Address
78.47.182.222 IP Address
115.182.88.152 IP Address

115.182.90.221 IP Address

This pane provides information about indicators related to the indicator, including the name
of the related indicator, its date created, its type, and its status. The following functions are

available.

« Linking an Indicator to an Event

« Unlinking an Indicator from an event
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« Sorting the list by date of creation or type
Use the dropdown menu.
« Accessing the indicator details page for one onf the related indicators
Click the indicator name.
Events Spearphish Details pane

This pane shows the raw Spearphish email content.

Event Details History Page

The Event Details History page provides a history of the event. The following function is

available:
« Show or hide details

Click the appropriate link.

Event Details Page: Procedures

Within this section is a comprehensive set of procedures found on the Event Details page.

The following options are available:

« Editing the Event Value

« Changing the Type Assigned to an Event

« Deleting an Event

o Adding an Attribute to an Event

o Deleting an Attribute from an Event

o Searching by Attribute

o Linking an Adversary to an Event

« Unlinking an Adversary from an Event
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o Editing the Confidence Level Associated with a Related Adversary

« Adding a Comment to a Related Adversary

« Editing a Comment for a Related Adversary

« Deleting a Comment from a Related Adversary

o Linking a File to an Event

o Unlinking a File from an Event

o Linking an Indicator to an Event

« Unlinking an Indicator from an event

Editing the Event Value
To edit the name of an event
1. Locate and click the event.
The Event Details page opens.
2. Click within the name field, and make the desired edits.

3. Click outside of the name field.

An Event updated confirmation alert appears in an alert bar at the top of the page.

Changing the Type Assigned to an Event
To change the type assigned to an event
1. Locate and click the event.
The Event Details page opens.

2. Click the event type dropdown menu, and select the desired type.
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Watering Hole
Spearphish
SQAL Injection Attack
DoS Attack
Malware

Malware object

An Event updated confirmation alert appears in an alert bar at the top of the

page.
Deleting an Event
To delete an event
1. Locate and click the event.
The Event Details page opens.
2. Click the Delete This Event button.
A warning dialog box appears.
3. To proceed, click Delete Event.

The Event Details page refreshes, and a confirmation alert appears in an alert bar at

the top of the page.

Adding an Attribute to an Event

To add an attribute
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1. Locate and click the event.
The Event Details page opens.
2. Inthe Details pane, click + Add Attribute.

The Add Attributes dialog box opens.

3. Inthe Add Attributes dialog box, specify the Attribute Name and Attribute Value.

ADD ATTRIBUTES

Attribute Name |

Source Type
Malware Family

MD5

Port

SHA-1
PhishTank 1D
CIDR Block
|P Address
URL

Target
Confidence

Source

Attribute Value

4. Click +.

5. Once you have added all desired attributes, click Add Attributes.

A confirmation alert appears in an alert bar at the top of the page.

Deleting an Attribute from an Event

To delete an attribute

1. Locate and click the event.

The Event Details page opens.
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. Inthe Details pane, select the attribute(s) you wish to delete.

Click Delete.

A confirmation dialog box opens asking if you are sure.
Click Delete Attribute.

The attribute is deleted, and a confirmation alert appears in an alert bar at the top of the

page.

Searching by Attribute

To search by attribute:

1.

Locate and click the event.

The Event Details page opens.

In the Details pane, click the Attribute you wish to search for.
The Indicator Search window opens.

Review search formatting, and add any other search criteria.

Click Search.
A results table appears below the search pane.

Linking an Adversary to an Event

To link an adversary to an event:

1.

2.

Locate and click the event.
The Event Details page opens.
In the Related Adversaries pane, click Link Adversary.

The Link an Adversary dialog box opens.
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3. Type the name of the adversary into the search field.

The system will provide typeahead suggestions, if any, based on what you have

typed.

4. Select one or more adversaries.
5. (Optional) Add a comment.
6. Click Link Adversary.

The adversary will be linked, and a confirmation alert appears in an alert bar at the top

of the page.
Unlinking an Adversary from an Event
To unlink an adversary from an event:
1. Locate and click the event.
The Event Details page opens.

2. In the Related Adversaries pane, select one or more adversaries you wish to

unlink.

3. Click Unlink.

A confirmation dialog box opens asking if you are sure.
4. Click Unlink Adversary.

The adversary will be unlinked, and a confirmation alert appears in an alert bar at the

top of the page.
Editing the Confidence Level Associated with a Related Adversary
The confidence level can be set to 0, 25, 50, 75, and 100.

To edit the confidence level:
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1. Locate and click the event the adversary is related to.
The Event Details page opens.

2. In the Related Adversaries pane, click the dropdown arrow to the right of the

adversary, and slide the scale to the desired confidence level.

The displayed confidence level will be modified to reflect your selection.

Adding a Comment to a Related Adversary
To add a comment:
1. Locate and click the event the adversary is related to.
The Event Details page opens.

2. In the Related Adversaries pane, click within the Comments field, and type your

comment.

3. Click Add Comment.
The comment is added, and a confirmation alert appears in an alert bar at the top of

the page.
Viewing a Comment for a Related Adversary
To view a comment:
1. Locate and click the event the adversary is related to.
The Event Details page opens.

2. In the Related Adversaries pane, locate the comment you wish to view.

3. Click the arrow to the right of the comment identity.

The comment field appears.
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Editing a Comment for a Related Adversary

To edit a comment:

. Locate and click the event the adversary is related to.

The Event Details page opens.

. In the Related Adversaries pane, locate the comment you wish to edit.

You can only edit comments you made.
Click Edit.
The comment field appears.

Make the desired edits.

Click Update Comment.

The comment is updated.

Deleting a Comment from a Related Adversary

To delete a comment:

1.

Locate and click the event the adversary is related to.

The Event Details page opens.

In the Related Adversaries pane, locate the comment you wish to delete.
You can only delete comments you made.

Click Delete.

The warning dialog box opens asking if you are sure.

Click Delete Comment.

The comment is deleted.

ThreatQ User Guide, Version 4.10 162



THREAT() AN Events

Linking a File to an Event
To link a file to an event:
1. Locate and click the event.
The Event Details page opens.
2. In the Related Files pane, click Link File.
The Link Files dialog box opens.
3. Type the name of the file you wish to link.

The system will provide typeahead suggestions, if any, based on what you have

typed.

4. Selectthe desired file(s).

5. Click Link File.
The file is added to the Related Files pane, and a confirmation appears in the alert bar

at the top of the page.

Unlinking a File from an Event
To unlink an indicator from an event:
1. Locate and click the event.
The Event Details page opens.
2. Inthe Related Files pane, select the file(s) you wish to unlink.

3. Click Unlink.
The selected file is unlinked, and a confirmation alert appears in an alert bar at the top

of the page.
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Linking an Indicator to an Event
To link an indicator to an event:
1. Locate and click the event you wish to link an indicator to.
The Event Details page opens.
2. In the Related Indicators pane, click Link Indicator.
The Link an Indicator dialog box opens.
3. Type the name of the indicator you wish to link.

The system will provide typeahead suggestions, if any, based on what you have

typed.

4. Select the indicator(s) you wish to link.
5. Click Link Indicator.

The selected indicator(s) are linked; the related indicators pane is updated, and a con-

firmation alert appears in an alert bar at the top of the page.

Unlinking an Indicator from an event
To unlink an indicator from an event:
1. Locate and click the event.
The Event Details page opens.
2. Inthe Related Indicators pane, select the indicator(s) you wish to unlink.

3. Click Unlink.
The selected indicator is unlinked, and a confirmation alert appears in an alert bar at

the top of the page.
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Adversaries

Adversaries are the suspected groups that are attempting to do malicious activity.

Within this section, the following options are available:

o Accessing the Adversaries Overview Page

o Adversaries Page: Information & Functions

Adding an Adversary

To add an adversary:

1.

Go to Create > Adversary.
The Add an Adversary dialog box opens.

Enter a name.

Select a Source from the dropdown menu provided.

"l

You can also click on Add a New Source if the desired source is not
listed in the dropdown menu

Enter a description.

Click Add Adversary.

The Adversary Details page opens for the adversary, and a confirmation alert appears

in an alert bar at the top of the page.
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Accessing the Adversaries Overview Page

« In the navigation menu, choose Analytics > Adversaries.

The Adversaries Overview page opens.

Adversaries Page: Information & Functions

The Adversaries page provides an overview of all the adversaries within ThreatQ as well as

overlapping use of specific indicators. There are three sections:

o Adversaries summary table

« Adversary Overlap table

o Indicator Distribution pie chart

Adversaries summary table

ADVERSARIES

Showing 110 10 of 20 entries Show
Adversary Name “  Number of Indicators Date Created Most Recent Event Date
Search

GROUGHING TIGER 08/30/2015 01:04 am 07/22/2015 09:41 am

DEAD RABBIT 08/30/2015 06:22 pm 08/26/2015 09:00 am
GREEN ANTILOPE 08/31/2015 01:04 pm
HIDDEN DRAGON 08/30/2015 03:50 pm 08/28/2015 00:00 am
HONEY BADGER 08/31/2015 12:02 pm
LONE WOLF 09/09/2015 01:06 pm
LONE WOLF2 09/12/2015 08:13 am
MARS SPIDER 08/30/2015 01:16 am

NEW ADVERSARY 08/31/2015 02:55 pm

M © o o o o © = w o

RUNNING FOX 08/30/2015 11:07 am

This table lists adversaries by name, number of indicators, date created, and the most recent

event date associated with the adversary. The following functions are available:

« Opening the Adversary Details page for an adversary

Click the name in the Adversary Name column.
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Performing a search for related indicators

Click the number in the Number of Indicators column to set the adversary name as a

search criterion and open the Advanced Search page.

Opening the Event Details page for an adversary event

Click the date in the Most Recent Event Date to open the Event Details page.

Changing the number of entries displayed in the table

Click the dropdown menu at the top right of the table, and select the desired option.

Sorting the table by a column

Click the column header. To reverse the column sorting order, click the header a

second time.

Searching within the Adversary Name column

Click within the search box at the top of the column, and enter your search criteria.

Adversary Overlap table

ADVERSARY OVERLAP

Showing 110 5 of § entries show( 10 % ]entries

Qverlapping
v
Date Adversaries Type Indicator
Search Search Search Search

08/31/2015 ZZ_THREATQA ADVERSARY03, ZZ_THREATQA ADVERSARY04, ZZ_THREATQA ADVERSARY0S, ZZ_THREATQA ADVERSARY06 P newert.com
10:30 am Address

08/31/2015 ZZ_THREATQA ADVERSARYO01, ZZ_THREATQA ADVERSARY03 FQDN overlap3.com
03:06 pm

08/31/2015 ZZ_THREATQA ADVERSARY01, 2Z_THREATQA ADVERSARY02, 2Z_THREATQA ADVERSARY03, Z2_THREATQA AD , 22_THREATQA AD , 22_THREATQA Email Re: Purchase
11:08am ADVERSARY08, DEAD RABBIT Subject Order

08/2912015 27 THREATQA ADVERSARY01, 2Z_THREATQA ADVERSARY02 [ 206.245.163.0/24
03:10pm Address

0971172015 GROUCHING TIGER, DEAD RABBIT P 212.007.199.085
03:22am

The Adversary Overlap table lists adversaries, the date and time they were created, their

type, and any overlapping indicators. The following functions are available:
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« Opening the Adversary Details page for an adversary
Click the name in the Adversary Name column.
« Opening the Indicator Details page for an overlapping indicator
Click the identity in the Overlapping Indicator column.
« Changing the number of entries displayed in the table
Click the dropdown menu at the top right of the table and select the desired option.
« Sorting the table by a column

Click the column header. To reverse the column sorting order, click the header a

second time.
« Searching within a column

Click within the search box at the top of the column, and enter your search criteria.

Indicator Distribution pie chart

INDICATOR DISTRIBUTION

CROUCHING TIGER
Il 77_THREATQA ADVERSARYO1
[ 22_THREATQA ADVERSARY02
ZZ_THREATQA ADVERSARY03
[l 7z_THREATQA ADVERSARYO0S

[ Last30Days w

RUNNING FOX: 2

MARS SPIDER:3 — ‘CROUCHING TIGER: 10

2Z_THREATQA ADVERSARY10: 4

2Z_THREATQA ADVERSARY0: 4

~ 2Z_THREATQA ADVERSARYO1: 8

22 THREATQA ADVERSARY06
22_THREATQA ADVERSARY04 22 THREATQA ADVERSARY07: 5 —_
I zZ_THREATQA ADVERSARY08
I DEAD RABBIT
[ zZ_THREATQA ADVERSARY07
I zZ_THREATQA ADVERSARY0S DEAD RABEIT: 5
22 THREATQA ADVERSARY10 ~ ZZ_THREATQA ADVERSARY02: 7
[ MARS SPIDER
I RUNNING FOX
22 THREATQA ADVERSARYOS: 5

ZZ_THREATQA ADVERSARYO3: 7
2Z_THREATQA ADVERSARYO4: 5

\
\ .
27_THREATOA ADVERSARYOS: 6 22 THREATQA ADVERSARY0S: 6

The Indicator Distribution pie chart shows you how many indicators were associated with all

adversaries, within a specified timeframe. The following functions are available:
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« Viewing more information about a selected value

Hover over a colored section of the pie chart to open a popup identifying the indicator,
the number of times the indicator was found within the specified timeframe, and what

percentage of the total number of indicators it represents.
« Hiding or unhiding one of the values from the pie chart

Click the indicator on the left of the pie chart to remove it; click a second time to rein-

state it.
« Adjusting the timeframe of the information displayed

Click the dropdown menu at the top right and select the desired timeframe.
« Printing the graph or saving it as a PNG, JPEG, PDF, or SVG

Click the hamburger menu (see graphic below), and select the desired option.

Adversary Details Page

The Adversary Details page provides a wide range of information and actions related to a

particular adversary.
Within this section, the following options are available:

o Accessing the Adversary Details Page for a Particular Adversary

« Adversary Details Page

Accessing the Adversary Details Page for a Particular Adversary

To access the Adversary Details page:
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« Locate and click the adversary.

The Adversary Details page opens.

Adversary Details Page
The Adversary Details page is made up of the following:

o Adversary Details header

o Three sub-tabs:

o Adversary Details: Summary page

« Adversary Details: Related Events page

« Adversary Details: History page

Adversary Details header

TH RE ATQ ” Indicators v Events Adversaries Files

i

CROUCHING TIGER

0 Related Adversaries - 0 Files - 3 Attributes - 5 Events - 6 Indicators - 1 Source

Summary  Related Events  History

At the top of the Adversary Details Summary page is a header with the adversary name,
date created, and a quick view list of the number of attributes, related events, related indic-

ators, and sources. The following functions are available:

« Editing the Name of an Adversary

o Deleting an Adversary

Adversary Details: Summary page

The Adversary Details: Summary page consists of three sections:
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« Details pane

o Related Indicators table

o Adversary Description pane

Details pane

= Add Attribute W Delete

Attributes (3)

Source Type
Malware Family

Port

Sources (1)

Threat Quotient

This pane provides information about the attributes and sources of the adversary, including

the name and date. The following functions are available:

o Adding an Attribute to an Adversary

« Deleting an Attribute from an Adversary

« Performing a search for a listed attribute
Click the attribute to set it as a search criterion and open the Indicator Search page.

For more information on using the indicator search tool, see Performing an Indicator

Search.
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Related Indicators table

RELATED INDICATORS S Link Indicator | £ Unlink

Sort: | Date of Indicator Creation %

08/29/15

212.227.89.182 IP Address
78.47.182.219 IP Address
78.47.182.222 IP Address
115.182.88.152 IP Address

115.182.90.221 IP Address

This table provides a list of related indicators. The following functions are available:

Sorting the list by Date of Indicator Creation or Indicator Type

Use the dropdown menu to select the desired option.

Accessing the Indicator Details page for a related indicator
Click the indicator.

o Linking an Indicator to an Adversary

Unlinking an Indicator from an Adversary

Adversary Description pane

This pane permits you to fill out information about an adversary. Itis a text editor that you can
use to paste in information from different files. You can put all supporting information related

to the adversary here, for future reference. The following functions are available:

« Adding an Adversary Description

o Editing an Adversary Description
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Adversary Details: Related Events page

This page provides information about events related to the adversary. The following function

is available:

o Linking an Event to an Adversary

Adversary Details: History page
This page provides a history of the adversary. The following function is available:

« Show or hide details

Click the appropriate link.

Adversary Details Page: Procedures

Within this section is a comprehensive set of procedures found on the Event Details page.

The following options are available:

« Editing the Name of an Adversary

o Deleting an Adversary

o Adding an Attribute to an Adversary

o Deleting an Attribute from an Adversary

o Searching by Attribute

o Adding an Adversary Description

o Editing an Adversary Description

o Linking an Event to an Adversary

« Unlinking an Event from an Adversary

ThreatQ User Guide, Version 4.10 173



TH ."-?E,ﬂ TQH Adversaries

o Linking an Indicator to an Adversary

« Unlinking an Indicator from an Adversary

Editing the Name of an Adversary
To edit the name of an adversary:
1. Locate and click the adversary.
The Adversary Details page opens.
2. Click within the name field, and make the desired edits.

3. Click outside of the name field.
The name is updated, and a confirmation alert appears in an alert bar at the top of the

page.
Deleting an Adversary
To delete an adversary:
1. Locate and click the adversary.
The Adversary Details page opens.
2. Click the Delete This Adversary button.
A confirmation dialog box appears.
3. To proceed, click Delete Adversary.

The Adversary Details page will refresh, and the alert bar will confirm the change.

Adding an Attribute to an Adversary

To add an attribute to an adversary:
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1. Locate and click the adversary.
The Event Details page opens.
2. Inthe Details pane, click + Add Attribute.

The Add Attributes dialog box opens.

3. Inthe Add Attributes dialog box, specify the Attribute Name and Attribute Value.

ADD ATTRIBUTES

Attribute Name ‘ Attribute Value
Source Type

Malware Family

MD5

Port

SHA-1
PhishTank ID
CIDR Block
IP Address
URL

Target
Confidence

Source

4. Click +.

5. Once you have added all desired attributes, click Add Attributes.

A confirmation alert appears in an alert bar at the top of the page.

Deleting an Attribute from an Adversary
To delete an attribute from an adversary:
1. Locate and click the adversary.

The Adversary Details page opens.

ThreatQ User Guide, Version 4.10

175



THREA Tﬂm Adversaries

2. Inthe Details pane, select the attribute(s) you wish to delete.

3. Click Delete.
A confirmation dialog box appears, asking if you wish to proceed.

4. Click Delete Attribute.

The attribute is deleted, and a confirmation alert appears in an alert bar at the top of the

page.
Searching by Attribute
To search by attribute:
1. Locate and click the adversary.
The Adversary Details page opens.
2. In the Details pane, click the Attribute you wish to search for.
The Search window opens.
3. Review search formatting and add any other search criteria.

4. Click Search.
A results table appears below the search pane.

Adding an Adversary Description
To add an adversary description:
1. Locate and click the adversary.
The Adversary Details page opens.

2. Click within the edit box in the Adversary Description pane.

3. Add the description.
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4. Click Save.

The description is saved, and a confirmation alert appears in the alert bar at the top of

the page.
Editing the Name of an Adversary
To edit the name of an adversary:
1. Locate and click the adversary.
The Adversary Details page opens.
2. Click within the name field, and make the desired edits.

3. Click outside of the name field.

The name is updated, and a confirmation alert appears in an alert bar at the top of the

page.
Linking an Event to an Adversary
To link an event to an adversary:
1. Locate and click the adversary.
The Adversary Details page opens.

2. Click the Related Events sub-tab.
3. Click Add an Event.

The Link an Event dialog box opens.
4. Type the name of the event you wish to link.

The system will provide typeahead suggestions, if any, based on what you have
typed.

5. Select the event from the list.
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6. Click Link Event.
The eventis linked, and a confirmation alert appears in an alert bar at the top of the

page.
Unlinking an Event from an Adversary
To unlink an event from an adversary:
1. Locate and click the adversary.
The Adversary Details page opens.
2. Click the Related Events sub-tab.

3. Locate the event you wish to unlink, and click Unlink.

A warning dialog box opens asking if you are sure.
4. Click Unlink Event.

The eventis unlinked, and a confirmation alert appears in an alert bar at the top of the

page.
Linking an Indicator to an Adversary
To link an indicator to an adversary:
1. Locate and click the adversary.
The Adversary Details page opens.
2. In the Related Indicators pane, click Link Indicator.

The Link an Indicator dialog box opens.
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3. Type the name of the indicator you wish to link.

The system will provide typeahead suggestions, if any, based on what you have
typed.

4. Selecteach indicator you wish to link.

5. Click Link Indicator.
The selected indicator(s) are linked, and a confirmation alert appears in an alert bar at

the top of the page.

Unlinking an Indicator from an Adversary
To unlink an indicator from an adversary:
1. Locate and click the file.
The Adversary Details page opens.
2. Inthe Related Indicators pane, select the indicator(s) you wish to unlink.

3. Click Unlink.
The selected indicator(s) are unlinked, and a confirmation alert appears in an alert bar

at the top of the page.
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Files

Files are received from various intelligence providers and contain information on indicators,

adversaries, and events within ThreatQ.
Within this section, the following options are available:

« Accessing the Files Overview Page

o Files Overview Page: Information & Functions

Adding a File
To add afile:
1. Click Create New > File.
The Add a File dialog box opens.

Drag the file into the dialog box or browse and locate the file.
Click Next Step.
The file will be imported.

Select whether to have the Malware Safety Lock on or off.

o g ~ w N

Identify the File Type.
Enabling the safety lop will create a .zip file so any malware is safer for download.
7. Add any desired tags.

Tags added appears on the File Details page.
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8. Click Save File.

The File Details page opens for the file, and a confirmation alert appears in an alert

bar at the top of the page.

Accessing the Files Overview Page
« In the navigation menu,choose Analytics > Files.

The Files Overview page opens.

Files Overview Page: Information & Functions
The Files page consists of two sections:

o Files Overview Page: Information & Functions

» Filestable
File Types pie chart

The File Types pie chart displays the percentage of different types of files within the system.
The following function is available:
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« Viewing more information about a selected file

Hover over a colored section of the pie chart to open a popup that gives the number of

attachment types.
« Printing the graph or saving itas a PNG, JPEG, PDF, or SVG

Click the hamburger menu (see graphic below), and select the desired option.

Files table

Date ~ Title Source Category Keywords

2017/06/07 07:25:41 test-file.txt threatq@threatq.com Generic Text
2017/05/12 05:30:15 mifr_426439.pdf threatq@threatq.com Generic Text

2017/05/09 00:20:19 IR-ALERT-MED-17-093-

ol

2017/05/08 06:57:03

2017/05/02 07:42:00
2017/05/02 05:36:50
2017/05/01 04:59:58

2017/05/01 04:58:35

LU L S L

2017/05/01 04:57:33

53b76b.xmI

2017/05/01 04:56:23 malwa

Immediately below the Browse pie chart is a table that lists the files, the date and time they
were created, their title, their source, their category, and associated keywords. The following

functions are available:
« Opening the File Details page for a file
Click the name in the Filename column.
« Changing the number of entries displayed in the table

Click the dropdown menu at the top right of the table and select the desired option.
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« Sorting the table by a column

Click the column header. To reverse the column sorting order, click the header a

second time.
« Searching within a column

Click within the search box at the top of the column, and enter your search criteria.
« Downloading a file

Click the download icon.

File Details Page
The File Details page provides more information about a particular file.
Within this section, the following options are available:

o Accessing the File Details Page for a Particular File

o File Details Page: Information & Functions

Accessing the File Details Page for a Particular File

1. In the navigation menu, choose Analytics > Files.

The Files Overview page opens.

2. Locate and click the file for which you want to view details.

The File Details page opens.

File Details Page: Information & Functions

The File Details page consists of the following:
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« File Details header

« File Details pane

o Related Indicators pane

File Details header

At the top of the File Details page is a header with the filename, and the date added and last

modified. The following function can be performed:

o Deleting a File

File Details pane

This table provides a list of file attributes (type, date and time created and last modified, file

name, file size, MIME type, and MD5). The following functions are available.

o Activating the Malware Safety Lock for a File

o Deactivating the Malware Safety Lock for a File

o Adding a New Tag to a File

« Downloading a File

Related Indicators pane

This table provides a list of related indicators. The following functions are available:

Sorting the list by Date of Indicator Creation or Indicator Type
Use the dropdown menu to select the desired option.

Accessing the Indicator Details page for a related indicator

Click the indicator.

Linking an Indicator to a File

Unlinking an Indicator from a File
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File Details Page: Procedures

Within this section is a comprehensive set of procedures found on the File Details page. The

following options are available:

o Deleting a File

o Activating the Malware Safety Lock for a File

o Deactivating the Malware Safety Lock for a File

o Adding a New Tag to a File

« Downloading a File

« Linking an Indicator to a File

« Unlinking an Indicator from a File

Deleting a File
To delete afile:
1. Locate and click the file.
The File Details page opens.
2. Click Delete This File.
A confirmation dialog box opens asking if you wish to proceed.
3. Click Delete File.

The file is deleted, and a confirmation alert appears in an alert bar at the top of the

page.
Activating the Malware Safety Lock for a File

Activating the Malware Safety Lock will .zip malware files, allowing users to download them

without accidentally opening them.
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To activate the malware safety lock for file:
1. Locate and click the file.
The File Details page opens.

2. Inthe File Details pane, slide the Malware Safety Lock to ON.

Deactivating the Malware Safety Lock for a File

To deactivate the malware safety lock for a file:

1. Locate and click the file.
2. The File Details page opens.

3. Inthe File Details pane, slide the Malware Safety Lock to OFF.
Adding a New Tag to a File
To add a new tag to afile:
1. Locate and click the file.
The File Details page opens.

2. Inthe File Details pane, under Tags, type the new tag into the New Tag field.

3. Press [enter].
Downloading a File
To download afile:
1. Locate and click the file.
The File Details page opens.

2. Inthe File Details pane, click Download File.
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Linking an Indicator to a File
To link an indicator to a file:
1. Locate and click the file.
The File Details page opens.
2. In the Related Indicators pane, click Link Indicator.
The Link an Indicator dialog box opens.
3. Type the name of the indicator you wish to link.

The system will provide typeahead suggestions, if any, based on what you have

typed.

4. Select each indicator you wish to link.

5. Click Link Indicator.
The selected indicator(s) are linked, and a confirmation alert appears in an alert bar at

the top of the page.

Unlinking an Indicator from a File
To unlink an indicator from a file:
1. Locate and click the file.
The File Details page opens.

2. In the Related Indicators pane, select the indicator(s) you wish to unlink.

3. Click Unlink.

The selected indicator(s) are unlinked, and a confirmation alert appears in an alert bar

at the top of the page.
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Signatures

The following describes how to manage signatures in ThreatQ.

o Signatures Overview

o Adding a Signature

o Signhatures Management

Signatures Overview

ThreatQ allows you to ingest and manage Signatures, such as Snort and OpenlOC. While
importing, ThreatQ parses the signature file for Indicators to add. Once signatures are
included in your deployment, you can add contextual information and correlate them with

Indicators, Events, Adversaries, and Files.
From the Signatures Overview page, you can do the following:

« View all signatures in the platform and details for each signature
« Filter signatures by Date Created, Signature Type, and Signature Title

« Add new signatures

Adding a Signature
1. From the main menu, choose Create > Signature.
The Add Signatures dialog box opens.
2. Choose Which type of signatures are you importing? from the drop-down menu.

For Yara, see Adding a Yara Signature.
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3. Select a Source from the dropdown menu provided.

You can also click on Add a New Source if the desired source is not
listed in the dropdown menu

5. Do one of the following:
« Drag your file(s) into the left pane.
« Click click to browse, and locate the file you wish to upload.
« Copy/paste contentin the right pane.

6. Optionally, select to parse the signature for indicators.
7. Choose a signature status from the drop-down menu.
8. Optionally, Apply attributes to all extracted signatures:

« Selectan Attribute Type.

Enter an Attribute Value.

Enter an Attribute Source.

Optionally, click the Add icon for additional attributes.

9. Optionally, relate the signature to another object by entering the object in the

Relate signatures to another object field.

10. Click Next Step.
If signatures are discovered, the Results dialog box appears.
« Click Review to accept or reject signatures before completing the import.
The Add Signatures Step 2: Review and submit page appears.
« Click Submit Import to skip review and finish adding the signatures.

The Signatures Overview page appears.
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11. If you selected to review signatures, choose from the following options:
« Select one or more signatures and click Delete.

« Click Create Signatures to add the signatures displayed on the page.
Adding a Yara Signature
1. From the main menu, choose Create > Signature.
The Add Signatures dialog box opens.

2. Choose Yara from theWhich type of signatures are you importing? from the drop-

down menu.

3. Select a Source from the dropdown menu provided.

You can also click on Add a New Source if the desired source is not
listed in the dropdown menu

5. Do one of the following:
« Drag your file(s) into the left pane.
« Click click to browse, and locate the file you wish to upload.
« Copy/paste contentin the right pane.

6. Optionally, select to parse the signature for indicators.

7. If multiple signatures are found in the yara file, select how you would like to pro-

ceed:
« Save each signature independently as a unique signature.

« Save as a single signature.
8. Choose a signature status from the drop-down menu.

9. Optionally, Apply attributes to all extracted signatures:
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« Selectan Attribute Type.

« Enter an Attribute Value.
« Enter an Attribute Source.
« Optionally, click the Add icon for additional attributes.

10. Optionally, relate the signature to another object by entering the object in the

Relate signatures to another object field.

11. Click Next Step.
If signatures are discovered, the Results dialog box appears.
« Click Review to accept or reject signatures before completing the import.
The Add Signatures Step 2: Review and submit page appears.
« Click Submit Import to skip review and finish adding the signatures.
The Signatures Overview page appears.

12. If you selected to review signatures, choose from the following options:
« Select one or more signatures and click Delete.

« Click Create Signatures to add the signatures displayed on the page.

Signatures Management

The Signatures Overview page displays all signatures in the platform. For each signature,

the table displays the Date Created, Signature Type, and Signature Title.

You can filter the table based on criteria to view specific signatures. For each signature, you

can click to view expanded details.
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Reports

The following describes how to generate reports in ThreatQ.

o Reports Overview

« Report Options

o Generating Reports

Reports Overview

You can exporta PDF Summary of an object from an object's details page.

( A

A The generated PDF may contain active links to internal and external loc-
ations. Related objects in the PDF link to an internal ThreatQ instance that
may require authentication. Please be aware of potential impacts before
distribution of the generated report.

Google Chrome's pop-up blocker prevents object PDF summary
reports from downloading. We recommend changing your browser set-
tings to allow pop-ups from your ThreatQ instance.

)

Report Options

You can navigate to Settings > Report Options to customize the PDF reports that are gen-
erated. Report options apply to all reports generated platform-wide. You can make the fol-

lowing customizations:

o Previewing Report Customization

« Customizing the Report Header
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o Customizing Report Text Colors

« Adding a Custom Disclaimer to a Report

Previewing Report Customization
You can preview report customization to view a representation of a report's output.
Procedure:

1. Select the Settings icon > Report Options.

2. Under Customized PDF Reports, click Preview.
The sample report downloads to your computer.
Customizing the Report Header
Complete the following steps to add a custom header to your PDF.

Procedure:

—

. Select the Settings icon > Report Options.
2. Under Header Banner, complete one of the following steps:

« Drag and drop the image you want to use as the header.

« Click Browse and navigate to the image you want to use as the header.

w

. Optionally, click Restore header banner to defaults.

4. Click Save.

Customizing Report Text Colors
Complete the following steps to customize the colors in your PDF.

Procedure:
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1. Select the Settings icon > Report Options.

2. Under Colors, use the drop down menus to select:

» Header Text
« Heading Text
» Body Text

3. Click Save.

Adding a Custom Disclaimer to a Report

You can add a custom disclaimer to include with your report to communicate any liabilities

or limitations to the end users of the report.
Procedure:
1. Select the Settings icon > Report Options.

2. Under Disclaimer,enter your disclaimer text and then use the formatting tools to cus-

tomize your message.

3. Click Save.

Generating Reports

Complete the following steps to export a PDF Summary of an object from an object's details

page.
Procedure:

1. Access the object's detail's page for which you want to generate a report summary.

2. Select Actions > Generate PDF.

The PDF summary downloads and opens in a new browser tab.
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G Google Chrome Users: Google Chrome's pop-up blocker prevents
object PDF summary reports from downloading. We recommend
changing your browser settings to allow pop-ups from your ThreatQ
instance. See Turning Off the Pop-up Blocker in Chrome for more
information.

A The generated PDF may contain active links to internal and external
locations. Related objects in the PDF link to an internal ThreatQ
instance that may require authentication. Please be aware of poten-
tial impacts before distribution of the generated report.

| J

Turning Off the Pop-up Blocker in Chrome

G\ This topic applies to ThreatQ version 4.7

By default, Google Chrome blocks pop-ups from automatically showing up on your screen.

When a pop-up is blocked, the address bar will display a pop-up blocked alert. This pop-up

blocker will prevent your PDF from being downloaded. Complete the following steps to

allow pop-ups from ThreatQ.

Procedure:

1.

2.

Go to ThreatQ where pop-ups are blocked.

In the address bar, click the Pop-up blocked alert icon.

. Click the link for the pop-up you want to see.

To always see pop-ups for the site, select Always allow pop-ups from [your ThreatQ

instance].

Click Done.
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Tasks

The following describes how to manage tasks in ThreatQ.

o Tasks Overview

» Assigning a Task

« Managing Tasks

Tasks Overview
ThreatQ allows you to create and assign tasks to yourself or other users in the platform.

Once tasks are included in your deployment, you can add contextual information and cor-
relate them with Indicators, Events, Adversaries, Signatures, and Files. You can also add

comments, change the task priority, change the task status, and delete the task.

Assigning a Task
Complete the following steps to assign a task in ThreatQ.
1. From the main menu, choose Create > Task.
The Add Task dialog box opens.

Enter a task Name.
Enter the assignee's email address in the Assigned To field.

Optionally, use the date picker to select a Due Date.

o &~ B

Select one of the following statuses:
« ToDo

« In Progress

ThreatQ User Guide, Version 4.10 196



THREAT() AN Tasks

o Review
o Done
6. Select one of the following task priorities:
o Low
o Medium
« High
7. Optionally, enter any Associated Objects.
8. Enter a Description for the task.

9. Click Save.

Managing Tasks
After a task is created, you can manage it on the task's Details page.

The following table describes the actions you can take to manage your tasks on a Task

Details page.
To You can...

Choose
the Priority
drop-down
Change task priority d select
and selec
a new pri-

ority.
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You can...

Choose

the Status

drop-down
Change task status

and select

a new

status.

Choose

the Add

Context
Add Attributes, Comments, Relationships, and Sources

drop-down

and select

an item.

Choose

View and Add Comments Comments

Choose

View the Audit Log Audit L
udit Log.
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Operations

The following explains how to configure and manage operations.

o Operations Overview

Operations Overview

Operations enhance your threat intelligence data by allowing you to add attributes, as well
as related indicators, from third party security services, both commercial and open source.
You accomplish this by creating objects to connect to a desired service, receive threat intel-

ligence, and display that threat intelligence in ThreatQ.

To develop custom operations, you should possess a basic functional knowledge of Python

version 3 development. In ThreatQ version 3.0 and later, you can create operations for:

« Indicators

Events

« Adversaries
« Files

Signatures

ThreatQ operations are written in Python v3.5.2. We recommend allocating a non-production
ThreatQ appliance for Operations development. You may use this development appliance to
troubleshoot your operations before deploying them to production. You may also setup a

local Python environment, write your script, and then copy it onto your ThreatQ appliance.

Installing Operations

You can install Operations from the user interface, instead of the command line.
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1. From the navigation menu, choose the gear icon > Operations Management.
2. Click Install Operation.
3. Choose one of the following:
» Drag and drop your operation package onto the Add Operation dialog box.

« Browse to your operation package, select it, and then click Open.

If successful, the operation appears in your list of operations where you can enable or

disable it.

Deleting Operations
Complete the following steps to delete an operation from ThreatQ:

1. From the navigation menu, choose the gear icon > Operations Management.
2. Forthe operation you want to delete, click Delete Operation.

3. Click Uninstall.
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Exports

The following explains how to configure and manage exports.

o Exports Overview

o Configuring Bro Exports

o Configuring Fidelis Exports

o Configuring Lancope Exports

« Configuring Netwithess Exports

« Configuring OpenlOC Signature Exports

« Configuring Palo Alto Exports

o Configuring Reservoir Labs Exports

o Configuring Splunk Exports

o Configuring Tenable Exports

Exports Overview

Exporting is one of the most important parts of ThreatQ as it allows you to output non-whitel-

isted indicators to an external threat detection system.

ThreatQ comes with a number of standard system exports that have previously been iden-
tified as useful. You have the option to use those and/or create your own. Within this sec-

tion, the following options are available:

o Viewing the Exports List

« Enabling/Disabling an Export

o Viewing an Export
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Exports

Duplicating an Export

Adding an Export

Accessing/Editing an Export’s Connection Settings

Accessing/Editing an Export's Output Format

Deleting an Export

Viewing the Exports List

EXPORTS (41)

Showing 110 41 of 41 entries

Off/On Name 4 URL Connection Output Format Actions
[e AreSight apilexportiarcsight duplicate
s AreSightEmailAddress apilexportiarcsightemail duplicate
e ArcSightEmailAttachments. apilexportiarcsightattachment duplicate
Le ArcSightEmailSubject apilexportiarcsightsubject duplicate
« ArcSightFQDN apilexport/arcsightfqdn duplicate
« ArcSightiPAddress apilexport/arcsightip duplicate
« ArcSightMD5 api/export/arcsightmds duplicate
< ArcSightString apilexport/arcsightstring duplicate
« ArcSightURL. api/export/arcsighturl duplicate
« ArcSightURLPath api/export/arcsighturipath duplicate
< ArcSightUserAgent apilexportiarcsightuseragent duplicate
« ArcSightXMailer api/export/arcsightxmailer duplicate
< Bro avilexcortibro dudlicate

To view the exports list:
« Go to ThreatQ Configuration > Exports

The Exports page opens with a table that lists all exports.

Enabling/Disabling an Export
To enable/disable an export:

1. Go to ThreatQ Configuration > Exports.
The Exports page opens with a list of exports.

Locate the export you wish to enable/disable.

> W N

Toggle the switch in the On/Off column to enable/disable the export.
A confirmation of your action appears in an alert bar at the top of the page.
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Viewing an Export
To view an export:
1. Go to ThreatQ Configuration > Exports.
The Exports page opens with a list of exports.
2. Click the desired URL.

A new tab opens in your browser, and you are taken to the data returned from that

export.
The load time may be lengthy depending on the amount of data being retumned.
Duplicating an Export
Duplicating an export allows you to have a version that you can edit.
To duplicate an export:
1. Go to ThreatQ Configuration > Exports.
The Exports page opens.

2. Locate the Export you wish to duplicate.
3. Click duplicate in the Actions column.

4. The duplicate appears at the bottom of the Exports table. A confirmation of the

duplication appears in an alert bar at the top of the page.
By default, the copy you just created is toggled Off.
Adding an Export

To add an export
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10.
11.

. Go to ThreatQ Configuration > Exports.

The Exports page opens.
Click + Add Export.
The Connection Settings dialog box opens.

Enter the Export name.
Verify or edit the token.

Click Next Step.
The Output Format dialog box opens.

For detailed information on formatting the Output Format dialog box, seeAccess-

ing/Editing an Export's Output FormatAccessing/Editing an Export's Output Format

Select which type of information you would like to export from the first dropdown

menu.
Select the Output type from the second dropdown menu.
(Optional) Enter special parameters.

Customize the Output Format Template by putting your cursor where you want
the variable to go and selecting the variable you’d like to use from the Insert Vari-

able select box.
Verify the information entered.

Click Save Settings.

The export you just created appears at the bottom of the Exports table, and a con-

firmation alert appears in an alert bar at the top of the page.

By default, the new exportis toggled Off.
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Accessing/Editing an Export’s Connection Settings

Connection settings are available for each of the exports. The Connection Settings dialog

box contains the name of the export as well as the token you’ll need to use when connecting

a device to ThreatQ.

While you cannot edit or delete any of the exports originally supplied by ThreatQ, you can

edit exports you have added to ThreatQ or copies of the original exports.

To edit an export's connection settings:

1.
2.

Go to ThreatQ Configuration > Exports.
Locate the export you wish to edit.

Click connection settings in the Connection column.

The Connection Settings dialog box opens.

CONNECTION SETTINGS

Export Name:

Tenable MD5 Address Copy

Token:

XHOOO0O0KK]

REVCRETL Il Cancel

Make the desired edits.

Click Save Settings.

The settings are saved, and a confirmation alert appears in an alert bar at the top of the

page.
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Accessing/Editing an Export's Output Format

While you cannot edit or delete any of the exports originally supplied by ThreatQ, you can

edit exports you have added to ThreatQ or copies of the original exports.
To edit an export's output format:

1. Go to ThreatQ Configuration > Exports.
2. Locate the export you wish to edit.

3. Click output format in the Output Format column.
The Output Format dialog box opens.

OUTPUT FORMAT

Which type of information would you like to export?

Indicators

Output type:

text/plain

Special Parameters (optional):
Provide URL Parameters to further refine information being exported: See examples.

indicator.deleted=N&indicator.type=MD5&indicator.class=network&status=Active
A

Output Format Tempilate: Insert Variable:
Indicator Id
{foreach $data as $indicator}

{$indicator.value}{foreach $indicator.Sources item=source name=Sources}

-

4. Select which type of information you would like to export from the first dropdown

menu.
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Which type of information would you like to export?

v Indicators
Recipients T
IndicatorSources

An admin has the ability to choose between the following options:

« Indicators - Outputs only indicators
« Recipients - Outputs only recipients

« IndicatorSources - Outputs indicators with the source as supporting inform-

ation

5. Select the Output Type from the second dropdown menu.

This sets the content type of the export response to a specific value (e.g. text/csv, tex-
t/plain, text/xml). Output Type does not have an impact on how the data is formatted
but it does affect the content type within the header of the exported document. For
example, if you select Output Type = text/csv, when viewing the source of the export,

the header will contain a Content Type = text/csv attribute.

Please see http://www.w3.org/Protocols/rfc1341/4 Content-Type.html for more

information.

N b ik b

text/xml
v text/plain
text/csv
text/csv; charset=utf-8
text/json
Custom

6. (Optional) Enter special parameters. There are two ways to do this:

o Option 1: Adding Special Parameters within ThreatQ. One advantage of

using this option is that the URL for the export remains non-specific and
therefore you can change what is being exported without having to man-

age each external device individually.
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o Option 2: Adding Parameters to the end of the URL. Choosing this option

means you lose the ability to have one place to manage what is being

exported.

Option 1: Adding Special Parameters within ThreatQ

This is where an admin can provide additional parameters to further specify which data will

be output via this export. Here are some examples.

To export all indicators with an

Indicator. Status=Active

active status
To export all CIDR Block indic- Indicator.Status=Active&Indicator. Type=cidr
ators that have an active status block

To export all CIDR Block indic-
ators and IP Addresses that have

an active status

block&Indicator. Type=ip address

Indicator.Status=Active&Indicator. Type=cidr

A wide range of filtering parameters are available:

Parameters for Indic- | Parameters for Recip- Parameters for Indicator
ators ients Sources
indicator.id recipient.id
o L indicator.id
indicator.type recipient.value o
o o indicator.type
indicator.status recipient.count o
o o indicator.status
indicator.value recipient.to_count
o o indicator.value
indicator.class recipient.cc_count
o o indicator.class
indicator.hash recipient.updated_at
o o indicator.hash
indicator.updated_at recipient.deleted
o o indicator.updated_at
indicator.last_detected_ recipient.deleted_at o
o ] indicator.last_detected_at
at recipient.spearphish_ o
indicator.deleted
indicator.deleted count o
indicator.deleted_at
indicator.deleted_at recipient. Adversaries o
indicator.source
indicator.Attributes recipient.Attributes
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Parameters for Indic-

ators

Parameters for Recip-

ients

Parameters for Indicator

Sources

indicator.Adversary
indicator.Sources

indicator.sources_count

recipient.Sources

Option 2: Adding Parameters to the end of the URL

You can append the same parameters listed above to the end of any export URL to achieve

the same results. By pursuing this option, you will lose the option of having one place to man-

age what is being exported via that export.

1. Customize the Output Format Template by putting your cursor where you want

the variable to go and selecting the variable you’d like to use from the Insert Vari-

able select box.

This template provides you with the ability to format exactly how your data is printed

out within an export.

Important: When formatting your output template, you must wrap all of your declar-

ations within a loop. Please refer to the following as an example:

{foreach S$Sdata as $indicator}

Your variables go here

{/foreach}

The Output Format Template is populated based on your selection.

2. Verify the information entered.
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3. Click Save Settings.
The settings are saved, and a confirmation alert appears in an alert bar at the top of the

page.
Deleting an Export

While you cannot delete any of the exports originally supplied by ThreatQ, you can delete

any exports you have added to ThreatQ or copies of the original exports.
To delete an export:

1. Go to ThreatQ Configuration > Exports.
2. Locate the export(s) you wish to delete.

3. Click the export(s).
4

. Click the delete icon at the top right of the Exports table.

Configuring Bro Exports

This topic explains how to export Bro indicators for use with an external threat detection sys-

tem. See Exports Overview for more details about configuring exports. Follow the instruc-

tions below to export your data.
To export to Bro:
1. From the navigation menu, choose the gear icon > Exports.
The Exports page appears.
2. Click Add New Export.
The Connection Settings dialog box appears.

3. Enter an Export Name.
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4. Click Next Step.
The Output Format dialog box appears.

5. Provide the following information:
« For Which type of information would you like to export? Choose: Indicators.
o For Output type, choose text/plain.

« Under Special Parameters, enter indic-

ator.status=Active&indicator.deleted=N

o Under Output Format Template, enter:
#fields{$tab}indicator{$tab}indicator_type{$tab}meta.source{$tab}meta.url
{foreach $data as $indicator}

{$indicator_type=""}

{$source_found=0}

{if $indicator.type eq "CIDR Block"}{$indicator_type="Intel:: SUBNET"}/if}
{if $indicator.type eq "IP Address"}{$indicator_type="Intel::ADDR"}/if}

{if $indicator.type eq "URL"}{$indicator_type="Intel::URL"}{/if}

{if $indicator.type eq "Email Address"}{$indicator_type="Intel::EMAIL"}{/if}
{if $indicator.type eq "FQDN"H{$indicator_type="Intel::DOMAIN"}H/if}

{if $indicator.type eq "MD5"}{$indicator_type="Intel::FILE_HASH"}{/if}

{if $indicator.type eq "SHA-1"{$indicator_type="Intel::FILE_HASH"}/if}
{if $indicator.type eq "SHA-256"}{$indicator_type="Intel::FILE_HASH"}{/if}

{if Sindicator.type eq "SHA-256"H{$indicator_type="Intel::FILE_HASH"}{/if}
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{if $indicator.type eq "SHA-384"}{$indicator_type="Intel::FILE_HASH"}{/if}
{if $indicator.type eq "SHA-512"H{$indicator_type="Intel::FILE_HASH"}{/if}
{if $indicator.type eq "Filename"}{S$indicator_type="Intel::FILE_HASH"}{/if}
{if $indicator_type ne "}

{$indicator.value}{$tab}{$indicator_type}{$tab}{foreach $indicator.Sources

item=source name=Sources}{if $smarty.foreach.Sources.first == true}
{$source.value}{$source_found=1}{/if}{/foreach}{if $source_found == 0}-{/if}
{$tab}https://{$http_host}/indicators/{$indicator.id}/details

{/it}

{/foreach}

6. Click Save Settings.

7. Under On/Off, toggle the switch to enable the export.

Configuring Fidelis Exports

This topic explains how to export Fidelis indicators for use with an external threat detection

system. See Exports Overview for more details about configuring exports. Follow the instruc-

tions below to export your data for:

« Fidelis FQDN
Fidelis FQDN Text

Fidelis IP Address

« Fidelis IP Address Text
Fildeis MD5

o Fidelis MD5 Text
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» Fidelis URL

o Fidelis URL Text

To export to Fidelis FQDN:

1.

From the navigation menu, choose the gear icon > Exports.
The Exports page appears.

Click Add New Export.

The Connection Settings dialog box appears.

Enter an Export Name.

Click Next Step.
The Output Format dialog box appears.

Provide the following information:
« For Which type of information would you like to export? Choose: Indicators
o For Output type, choose text/xml.

« Under Special Parameters, enter indic-
ator.status-
s=Active&indicator.deleted=N&indicator.type=FQDN&indicator.class=host

o Under Output Format Template, enter:
<MyMD5feed/>

<description>FQDN feed provided by ThreatQuotient. Possible request para-
meters are listed as attributes on the result node. The dateBegin parameter

defaults to one hour prior. Stay secure my friends!</description>
<entries>

<limit>{$row_count}</limit>
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<page>{$row_count}</page>
<start>{$row_count}</start>

<end>{$row_count}</end>
<status>{$row_count}</status>
<rows_returned>{$row_count}</rows_returned>
<entry>

{foreach $data as $indicator}
<hostname>{$indicator.value|escape:"url"}</hostname>
<extra_info>https://{$http_host}/indicators/{$indicator.id}/details</extra_info>
{/foreach}

</entry>

</entries>

6. Click Save Settings.

7. Under On/Off, toggle the switch to enable the export.
To export to Fidelis FQDN Text:
1. From the navigation menu, choose the gear icon > Exports.
The Exports page appears.
2. Click Add New Export.
The Connection Settings dialog box appears.

3. Enter an Export Name.
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4. Click Next Step.
The Output Format dialog box appears.

5. Provide the following information:
« For Which type of information would you like to export? Choose: Indicators.
o For Output type, choose text/plain

« Under Special Parameters, enter indic-
ator.status-
s=Active&indicator.deleted=N&indicator.type=FQDNG&indicator.class=host

« Under Output Format Template, enter:
{foreach $data as $indicator}
{$indicator.value}

{/foreach}

6. Click Save Settings.

7. Under On/Off, toggle the switch to enable the export.
To export to Fidelis IP Address:
1. From the navigation menu, choose the gear icon > Exports.
The Exports page appears.
2. Click Add New Export.
The Connection Settings dialog box appears.

3. Enter an Export Name.

4. Click Next Step.

The Output Format dialog box appears.
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5. Provide the following information:
« For Which type of information would you like to export? Choose: Indicators.
« For Output type, choose text/xml.

« Under Special Parameters, enter indic-
ator.status=Active&indicator.deleted=N&indicator.type=IP Address&in-

dicator.class=network.

o Under Output Format Template, enter:
<MyMDb5feed/>

<description>IP feed provided by ThreatQuotient. Possible request para-
meters are listed as attributes on the result node. The dateBegin parameter

defaults to one hour prior. Stay secure my friends!</description>
<entries>

<limit>{$row_count}</limit>
<page>{$row_count}</page>
<start>{$row_count}</start>
<end>{$row_count}</end>
<status>{$row_count}</status>
<rows_returned>{$row_count}</rows_returned>
<entry>

{foreach $data as $indicator}
<ip>{$indicator.value|escape:"url"}</ip>

<extra_info>https://{$http_host}/indicators/{$indicator.id}/details</extra_info>
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6.
7.

{/foreach}
</entry>
</entries>

Click Save Settings.

Under On/Off, toggle the switch to enable the export.

To export to Fidelis IP Address Text:

1.

From the navigation menu, choose the gear icon > Exports.
The Exports page appears.

Click Add New Export.

The Connection Settings dialog box appears.

Enter an Export Name.

Click Next Step.

The Output Format dialog box appears.

. Provide the following information:

« For Which type of information would you like to export? Choose: Indicators.
« For Output type, choose text/plain.

« Under Special Parameters, enter indic-
ator.status=Active&indicator.deleted=N&indicator.type=IP Address&in-

dicator.class=network.

o Under Output Format Template, enter:
{foreach $data as $indicator}

{$indicator.value}
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{/foreach}

6. Click Save Settings.

7. Under On/Off, toggle the switch to enable the export.
To export to Fidelis MD5:
1. From the navigation menu, choose the gear icon > Exports.
The Exports page appears.
2. Click Add New Export.
The Connection Settings dialog box appears.

3. Enter an Export Name.

4. Click Next Step.
The Output Format dialog box appears.

5. Provide the following information:
« For Which type of information would you like to export? Choose: Indicators.
o For Output type, choose text/xml.

« Under Special Parameters, enter indic-
ator.status-

s=Active&indicator.deleted=N&indicator.type=MD5&indicator.class=host.

« Under Output Format Template, enter:
<MyMD5feed/>

<description>MDD5 feed provided by ThreatQuotient. Possible request para-
meters are listed as attributes on the result node. The dateBegin parameter

defaults to one hour prior. Stay secure my friends!</description>

<entries>
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<limit>{$row_count}</limit>
<page>{$row_count}</page>
<start>{$row_count}</start>
<end>{$row_count}</end>
<status>{$row_count}</status>
<rows_returned>{$row_count}</rows_returned>
<entry>

{foreach $data as $indicator}
<md5>{S$indicator.value|escape:"url"}}</md5>
<extra_info>https://{$http_host}/indicators/{$indicator.id}/details</extra_info>
{/foreach}

</entry>

</entries>

6. Click Save Settings.

7. Under On/Off, toggle the switch to enable the export.
To export to Fidelis MD5 Text:
1. From the navigation menu, choose the gear icon > Exports.
The Exports page appears.
2. Click Add New Export.

The Connection Settings dialog box appears.
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3. Enter an Export Name.

4. Click Next Step.
The Output Format dialog box appears.

5. Provide the following information:
« For Which type of information would you like to export? Choose: Indicators.
« ForOutput type, choose: text/plain.

« Under Special Parameters, enter indic-
ator.status-
s=Active&indicator.deleted=N&indicator.type=MD5&indicator.class=host

o Under Output Format Template, enter:
{foreach $data as $indicator}
{$indicator.value}

{/foreach}

6. Click Save Settings.

7. Under On/Off, toggle the switch to enable the export.
To export to Fidelis URL:
1. From the navigation menu, choose the gear icon > Exports.
The Exports page appears.
2. Click Add New Export.
The Connection Settings dialog box appears.

3. Enter an Export Name.
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4. Click Next Step.
The Output Format dialog box appears.

5. Provide the following information:
« For Which type of information would you like to export? Choose: Indicators.
o For Output type, choose text/plain.

« Under Special Parameters, enter: indic-

ator.status=Active&indicator.deleted=N

o Under Output Format Template, enter:
<MyMDb5feed/>

<description>URL feed provided by ThreatQuotient. Possible request para-
meters are listed as attributes on the result node. The dateBegin parameter

defaults to one hour prior. Stay secure my friends!</description>
<entries>

<limit>{$row_count}</limit>

<page>{$row_count}</page>

<start>{$row_count}</start>

<end>{$row_count}</end>

<status>{$row_count}</status>
<rows_returned>{$row_count}</rows_returned>

<entry>

{foreach $data as $indicator}

<url>{$indicator.value|escape:"url"}}</url>
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6.
7.

<extra_info>https://{$http_host}/indicators/{$indicator.id}/details</extra_info>
{/foreach}

</entry>

</entries>

Click Save Settings.

Under On/Off, toggle the switch to enable the export.

To export to Fidelis URL Text:

1.

From the navigation menu, choose the gear icon > Exports.
The Exports page appears.

Click Add New Export.

The Connection Settings dialog box appears.

Enter an Export Name.

Click Next Step.
The Output Format dialog box appears.

Provide the following information:
« For Which type of information would you like to export? Choose: Indicators.
« For Output type: choose text/plain.

« Under Special Parameters, enter indic-
ator.status-

s=Active&indicator.deleted=N&indicator.type=URL&indicator.class=host

o Under Output Format Template, enter:

{foreach $data as $indicator}
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{$indicator.value}
{/foreach}

6. Click Save Settings.

7. Under On/Off, toggle the switch to enable the export.

Configuring Lancope Exports

This topic explains how to export Lancope indicators for use with an external threat detection

system. See Exports Overview for more details about configuring exports. Follow the instruc-

tions below configure an export for your data.
To export to Lancope:
1. From the navigation menu, choose the gear icon > Exports.
The Exports page appears.
2. Click Add New Export.
The Connection Settings dialog box appears.

3. Enter an Export Name.

4. Click Next Step.
The Output Format dialog box appears.

5. Provide the following information:
« For Which type of information would you like to export? Choose Indicators.
« ForOutput type, choose text/csv; charset=utf-8

« Under Special Parameters, enter:

indicator.status=Active&indicator.deleted=N&indicator.type=IP
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Addressg&indicator.type=CIDR Block&indicator.class=network
o Under Output Format Template, enter:

RECORD_NUMBER,GROUP_NAME,GROUP_ID,NETWORK _
DEFINITION,PARENT_NAMESPACE

0,ThreatQ,-1,,/
{foreach $data as $indicator}

0,"{foreach $indicator.Sources item=source name=Sources}{$source.value}

{if $smarty.foreach.Sources.last != true},{/if}{/foreach}",-1,
{$indicator.value|regex_replace:"/[\r\t\n]/":""|replace:"\"":""},"/ThreatQ/"
{/foreach}

6. Click Save Settings.
7. Under On/Off, toggle the switch to enable the export.

Configuring Netwitness Exports

This topic explains how to export Netwitness indicators for use with an external threat detec-

tion system. See Exports Overview for more details about configuring exports. Follow the

instructions below to export your data for:

« Netwitness FQDN

« Netwitness IP
To export to Netwitness FQDN:
1. From the navigation menu, choose the gear icon > Exports.

The Exports page appears.
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2. Click Add New Export.
The Connection Settings dialog box appears.

3. Enter an Export Name.

4. Click Next Step.
The Output Format dialog box appears.

5. Provide the following information:
« For Which type of information would you like to export? Choose Indicators.
« For Output type, choose text/csv; charset=utf-8.

« Under Special Parameters, enter:

indic-

ator.status-

=Ac-
ctive&indicator.deleted=N&indicator.type=FQDNG&indicator.class=network

o Under Output Format Template, enter:
{foreach $data as $indicator}
"{$indicator.value}","{foreach $indicator.Sources as $source}{$source.value},
{foreachelse}{/foreach}","https://{$http_host}/indicators/{$indicator.id}/details"
{/foreach}

6. Click Save Settings.

7. Under On/Off, toggle the switch to enable the export.

To export to Netwitness IP:
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1.

6.
7.

From the navigation menu, choose the gear icon > Exports.
The Exports page appears.

Click Add New Export.

The Connection Settings dialog box appears.

Enter an Export Name.

Click Next Step.
The Output Format dialog box appears.

Provide the following information:
« For Which type of information would you like to export? Choose Indicators.
« For Output type, choose text/csv; charset=utf-8.
« Under Special Parameters, enter:

indicator.status=Active&indicator.deleted=N&indicator.type=IP Address&in-

dicator.class=network
« Under Output Format Template, enter:
{foreach $data as $indicator}

"{$indicator.value}","{foreach $indicator.Sources as $source}{$source.value},
{foreachelse}{/foreach}","https://{$http_host}/indicators/{$indicator.id}/details"

{/foreach}

Click Save Settings.

Under On/Off, toggle the switch to enable the export.
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Configuring OpenlOC Signature Exports

This topic explains how to export OpenlOC signatures for use with an external threat detec-

tion system. See Exports Overview for more details about configuring exports. Follow the

instructions below to export your data.

To export to OpenlOC CSV:

1.

From the navigation menu, choose the gear icon > Exports.
The Exports page appears.

Click Add New Export.

The Connection Settings dialog box appears.

Enter an Export Name.

Click Next Step.
The Output Format dialog box appears.

Provide the following information:
« For Which type of information would you like to export? Choose Signatures.
« For Output type, choose text/csv.

« Under Special Parameters, enter:
signature.status=Active&signature.deleted=N&signature.type=OpenlOC
« Under Output Format Template, enter:
{foreach $data as $signature}
"{$signature.name]replace:"™":\"}","{$signature.value|replace:"™":\"}"

{/foreach}
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6.
7.

Click Save Settings.

Under On/Off, toggle the switch to enable the export.

Configuring Palo Alto Exports

This topic explains how to export Palo Alto indicators for use with an external threat detec-

tion system. See Exports Overview for more details about configuring exports. Follow the

instructions below to export your data.

To export to Palo Alto FQDN:

1.

From the navigation menu, choose the gear icon > Exports.
The Exports page appears.

Click Add New Export.

The Connection Settings dialog box appears.

Enter an Export Name.

Click Next Step.
The Output Format dialog box appears.

Provide the following information:
« For Which type of information would you like to export? Choose Indicators.
o For Output type, choose text/plain.
« Under Special Parameters, enter:
indic-
ator.status-
=Ac-
ctive&indicator.deleted=NG&indicator.type=FQDN&indicator.class=network
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« Under Output Format Template, enter:
{foreach $data as $indicator}
{$indicator.value}

* {$indicator.value}
{/foreach}

6. Click Save Settings.

7. Under On/Off, toggle the switch to enable the export.

Configuring Reservoir Labs Exports

This topic explains how to export Reservoir Labs indicators for use with an external threat

detection system. See Exports Overview for more details about configuring exports. Follow

the instructions below to export your data.
To export to Reservoir Labs:
1. From the navigation menu, choose the gear icon > Exports.
The Exports page appears.
2. Click Add New Export.
The Connection Settings dialog box appears.

3. Enter an Export Name.

4. Click Next Step.

The Output Format dialog box appears.
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5. Provide the following information:
« For Which type of information would you like to export? Choose Indicators.
« For Output type, choose text/plain.

« Under Special Parameters, enter:
indicator.status=Active&indicator.deleted=N
« Under Output Format Template, enter:
#fields{$tab}indicator{$tab}indicator_type{$tab}meta.source{$tab}meta.url
{foreach $data as $indicator}
{if $indicator.type eq "CIDR Block"}{continue}{/if}
{if $indicator.type eq "SHA-1"}H{continue}{/if}
{if $indicator.type eq "SHA-256"Hcontinue}{/if}
{if Sindicator.type eq "SHA-384"}continue}{/if}
{if Sindicator.type eq "SHA-512"Hcontinue}{/if}
{$indicator_type=""}
{$source_found=0}
{if $indicator.type eq "IP Address"}{$indicator_type="Intel:: ADDR"}{/if}
{if $indicator.type eq "URL"}{$indicator_type="Intel::URL"}{/if}
{if $indicator.type eq "Email Address"}{$indicator_type="Intel::EMAIL"}{/if}
{if $indicator.type eq "FQDN"H{$indicator_type="Intel::DOMAIN"}H/if}

{if $indicator.type eq "MD5"}{$indicator_type="Intel::FILE_HASH"}{/if}

ThreatQ User Guide, Version 4.10 230



THREAT() AN Exports

{if $indicator.type eq "Filename"H{$indicator_type="Intel::FILE_HASH"}{/if}

{if $indicator_type ne "}

{$indicator.value}{$tab}{$indicator_type}{$tab}{foreach $indicator.Sources
item=source name=Sources}{if $smarty.foreach.Sources.first == true}

{$source.value}{$source_found=1}{/if{/foreach}{if $source_found == 0}-{/if}
{$tab}https://{$http_host}/indicators/{$indicator.id}/details

{/if}

{/foreach}

6. Click Save Settings.

7. Under On/Off, toggle the switch to enable the export.

Configuring Splunk Exports

This topic explains how to export indicators for use with an external threat detection system.

See Exports Overview for more details about configuring exports. Follow the instructions

below to export your data.
To export to Splunk:
1. From the navigation menu, choose the gear icon > Exports.
The Exports page appears.
2. Click Add New Export.
The Connection Settings dialog box appears.

3. Enter an Export Name.
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4. Click Next Step.

The Output Format dialog box appears.

Provide the following information:
For Which type of information would you like to export? Choose Indicators.
For Output type, choose text/plain.

Under Special Parameters, enter:
indicator.sincedeleted=Y
Under Output Format Template, enter:

#indicator{$tab}indicator_type{$tab}last_modified{$tab}reference_url{$tab}-
source{$tab}campaign{$tab}status

{foreach $data as $indicator}
{$indicator.value}{$tab}{S$indicator.type}{$indicator.updated_at}

{$tab}https://{$http_host}/indicators/{$indicator.id}/details{$tab}{foreach $in-
dicator.Sources item=source name=Sources}{$source.value}{if $smarty.-
foreach.Sources.last == false}, {/if}{/foreach}{$tab}{foreach
$indicator.Adversaries item=adversary name=Adversaries}{$ad-
versary.value}l{if $smarty.foreach.Adversaries.last == false}, {/if}{/foreach}
{$tab}{$indicator.status}

{/foreach}

5. Click Save Settings.

6. Under On/Off, toggle the switch to enable the export.
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Configuring Tenable Exports

This topic explains how to export Tenable indicators for use with an external threat detection

system. See Exports Overview for more details about configuring exports. Follow the instruc-

tions below to export your data for:

« Tenable FQDN
« Tenable IP Address
« Tenable MD5 Address

To export to Tenable FQDN:
1. From the navigation menu, choose the gear icon > Exports.
The Exports page appears.
2. Click Add New Export.
The Connection Settings dialog box appears.

3. Enter an Export Name.

4. Click Next Step.
The Output Format dialog box appears.

5. Provide the following information:
« For Which type of information would you like to export? Choose Indicators.
o For Output type, choose text/plain.
« Under Special Parameters, enter:
indic-
ator.status-
=Ac-
ctive&indicator.deleted=NG&indicator.type=FQDN&indicator.class=network
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« Under Output Format Template, enter:
{foreach $data as $indicator}
{$indicator.value},{foreach $indicator.Sources item=source name=Sources}
{$source.value}{if $smarty.foreach.Sources.last == false}/{/if}{/foreach}
{/foreach}

6. Click Save Settings.

7. Under On/Off, toggle the switch to enable the export.
To export to Tenable |P Address:

1. From the navigation menu, choose the gear icon > Exports.
The Exports page appears.

Click Add New Export.

The Connection Settings dialog box appears.

Enter an Export Name.

Click Next Step.

The Output Format dialog box appears.

© N o O bk~ W D

Provide the following information:

For Which type of information would you like to export? Choose Indicators.

For Output type, choose text/plain.

Under Special Parameters, enter:

indicator.status=Active&indicator.deleted=N&indicator.type=IP Address&in-

dicator.class=network

Under Output Format Template, enter:

{foreach $data as $indicator}
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{$indicator.value},{foreach $indicator.Sources item=source name=Sources}
{$source.value}{if $smarty.foreach.Sources.last == false}/{/if}{/foreach}

{/foreach}

9. Click Save Settings.

10. Under On/Off, toggle the switch to enable the export.

To export to Tenable MD5 Address:

1.

2 T

From the navigation menu, choose the gear icon > Exports.

The Exports page appears.

Click Add New Export.

The Connection Settings dialog box appears.

Enter an Export Name.

Click Next Step.

The Output Format dialog box appears.

Provide the following information:

For Which type of information would you like to export? Choose Indicators.
For Output type, choose text/plain.

Under Special Parameters, enter:

indic-

ator.status-
s=Active&indicator.deleted=NG&indicator.type=MD5g&indicator.class=network

Under Output Format Template, enter:

{foreach $data as $indicator}
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« {$indicator.value},{foreach $indicator.Sources item=source name-

e=Sources}
« {$source.value}{if $smarty.foreach.Sources.last == false}/{/if}{/foreach}
« {/foreach}
7. Click Save Settings.

8. Under On/Off, toggle the switch to enable the export.
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Common Enrichment and Audit Log Ques-
tions

The ThreatQ Audit Log tracks every change made to every objectin the system. If there is a
change to an object, that change is displayed in the audit log. The audit log is only updated if

the data itself changes, not just the updated_at value.
The following questions below address further details about the audit logging process.

In the case where an activity is triggered (with nothing updated), where will the activity be
logged?

The activity will not show in the audit log, as there were no changes to report. While ThreatQ
does not track duplicate objects that enter the application, there is a touched_at date field on
primary objects (Adversaries, Files, Events, Indicators, and Signatures) that indicates when

a relation of the object has been changed.

Is there another raw audit log within the system where events are logged?

No, there are no other raw audit logs where events are logged.

Is there an option in the User Interface to enable all activities to be shown in the Audit
Log?

There is no option in the User Interface to limit or expand the audit log. All entries are pulled
for an object when the Audit Log panel is opened. The audit log displays changes to the indi-
vidual fields of an object; object comments, sources, attributes, and tags; as well as to object
links, object link comments, and object link attributes. Additionally, any changes to the score

of an Indicator are included.
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Backup and Restore

The following describes how to back up and restore a ThreatQ instance.

o ThreatQ Backup

« ThreatQ Restore

ThreatQ Backup

Before performing a backup of a ThreatQ instance, note the following:

« The backup process stops and starts all ThreatQ services automatically in order to
prevent modifications to the file system and database. Requests made during this

time are queued and resumed once the backup process completes.

« The time it takes to back up ThreatQ depends primarily on the size of the data-
base. For this reason, we recommend performing a backup when system avail-

ability is not critical, such as during a scheduled maintenance window.

» The resulting backup file can be large. We recommend that you write it to a moun-
ted drive or file location rather than the local file system. For instructions on how to
mount a network-available drive, contact ThreatQ Support. If the backup file must
be stored locally, you should move it off the local file system at the earliest oppor-
tunity.

» By default, the system creates a backup of the threat intelligence data index
required for improved search performance and includes it in the backup file. This
operation may take hours. You can omit this portion of the backup by running the
backup command with the --exclude-solr option. However, this means that your

threat intelligence data must be re-indexed during or after the restore process.
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Backing Up a ThreatQ Instance

By default, the system creates a backup of the threat intelligence data index required for

improved search performance and includes it in the backup file. This operation may take

hours. You can omit this portion of the backup by running the backup command with the --

exclude-solr option. However, this means that your threat intelligence data must be re-

indexed during or after the restore process.

Before you begin, refer to ThreatQ Backup.

To perform a ThreatQ backup:

1.
2.

4.
5.

SSH to the ThreatQ command line and elevate your user privilege to root or sudo.
Change the directory to /var/www/api.
Choose one of the following options:

« To create a backup thatincludes a Threat Library re-index, run the following

command: sudo php artisan threatq:backup.

» To create a backup that excludes a Threat Library re-index, run the following

command: sudo php artisan threatq:backup --exclude-solr.
When prompted, provide the root mysql password you configured during first boot.

Provide the path to the file location where you want to create the backup.

The script generates a backup file in the specified file location. The name of the file will be

threatq_backup_x.x.x_yyyy-mm-dd.tgz, where x.x.x is the TQ version and yyyy-mm-dd is

the date when the backup was performed.

ThreatQ Restore

To restore from a ThreatQ backup, note the following:
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« The target machine must be an existing ThreatQ instance running the same ver-

sion of the instance captured in the backup.
« The restore process completely overwrites the current installation.

« The backup file needs to be accessible by the target ThreatQ instance, either loc-

ally or on a mounted drive.

« The backup file will be unzipped in the same directory where it resides. Ensure
that the available disk has sufficient space to hold both the backup archive and the
extracted directory. The extracted directory can be removed after the restore is com-

plete.

« Depending on the size of the instance being restored, the process can take a

while.

« The machine running the target ThreatQ instance automatically restarts once the

restore process is complete.

How to Restore from a ThreatQ Backup

Before you begin, refer to ThreatQ Restore.

To restore from a ThreatQ backup, perform the following procedure on the target ThreatQ

instance.

1. Complete the first boot process on the new host by navigating to its IP address in a
web browser and entering your credentials. If this step is not completed, the remain-

ing steps are not successful.
2. SSH to the command line and elevate your user privileges to root or sudo.

3. Verify that you have the necessary utilities in place by running: yum install poli-
cycoreutils-python-2.2.5-20.el7.x86_64.

4. Change directory to /var/www/api.
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5. Issue the following commands:
« php artisan threatq:restore </path/to/backup_file>
« php artisan threatq:update-events
6. When prompted, provide the root mysql password you configured during first boot.

7. Ifthe backup file does not include the intelligence data index required for improved
search performance, the system prompts you to either allow an automatic re-index

or manually perform it later.
This operation may take hours.

8. After the restore completes, you should reboot the target ThreatQ system to ensure

that the system processes start up correctly.
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OAuth Management

The OAuth Management section is where you can find your credentials, a unique Client ID,

which will allow you to connect with ThreatQ's API.
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